This document is the operation manual for Dr. Engrave for Windows, a program for plate engraving.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>4</td>
</tr>
<tr>
<td>Operating environment</td>
<td>5</td>
</tr>
<tr>
<td>Overview of Dr. Engrave</td>
<td>5</td>
</tr>
<tr>
<td>Starting the software</td>
<td>6</td>
</tr>
<tr>
<td>Names and functions of screen items</td>
<td>7</td>
</tr>
<tr>
<td>Operation Procedures</td>
<td>8</td>
</tr>
<tr>
<td>Introduction</td>
<td>9</td>
</tr>
<tr>
<td>Step 1: Enter the workpiece size</td>
<td>10</td>
</tr>
<tr>
<td>Step 2: Set the cutting conditions</td>
<td>11</td>
</tr>
<tr>
<td>Step 3: Enter the text</td>
<td>12</td>
</tr>
<tr>
<td>Step 4: Draw graphics</td>
<td>12</td>
</tr>
<tr>
<td>Step 5: Import an image file</td>
<td>13</td>
</tr>
<tr>
<td>Step 6: Save the file</td>
<td>13</td>
</tr>
<tr>
<td>Step 7: Start engraving</td>
<td>13</td>
</tr>
<tr>
<td>Basic Operations for Objects</td>
<td>13</td>
</tr>
<tr>
<td>Selecting an object</td>
<td>14</td>
</tr>
<tr>
<td>Canceling the selection of an object</td>
<td>14</td>
</tr>
<tr>
<td>Moving an object horizontally or vertically</td>
<td>14</td>
</tr>
<tr>
<td>Making an object larger or smaller</td>
<td>14</td>
</tr>
<tr>
<td>Rotating an object</td>
<td>14</td>
</tr>
<tr>
<td>Slanting an object</td>
<td>15</td>
</tr>
<tr>
<td>Copying an object</td>
<td>15</td>
</tr>
<tr>
<td>Deleting an object</td>
<td>15</td>
</tr>
<tr>
<td>Selecting a vertex of a polygon (polyline)</td>
<td>15</td>
</tr>
<tr>
<td>Selecting multiple vertices of a polygon (polyline)</td>
<td>15</td>
</tr>
<tr>
<td>Selecting all vertices of a polygon (polyline)</td>
<td>16</td>
</tr>
<tr>
<td>Moving a vertex of a polygon (polyline) horizontally or vertically</td>
<td>16</td>
</tr>
<tr>
<td>Adding a vertex to a polygon (polyline)</td>
<td>16</td>
</tr>
<tr>
<td>Deleting a vertex of a polygon (polyline)</td>
<td>16</td>
</tr>
<tr>
<td>Hints and Tips</td>
<td>17</td>
</tr>
<tr>
<td>About the origin point for engraving</td>
<td>18</td>
</tr>
<tr>
<td>Changing the engraving depth</td>
<td>18</td>
</tr>
<tr>
<td>Arranging plates of the same size for engraving at one time</td>
<td>19</td>
</tr>
<tr>
<td>Dividing a single plate to create multiple plates</td>
<td>22</td>
</tr>
<tr>
<td>Re-engraving a desired plate</td>
<td>25</td>
</tr>
<tr>
<td>Importing a text file into a text box</td>
<td>25</td>
</tr>
<tr>
<td>Speeding up text engraving</td>
<td>26</td>
</tr>
<tr>
<td>Creating shapes (such as circles and squares) with a vertical/</td>
<td>26</td>
</tr>
<tr>
<td>horizontal aspect of 1:1</td>
<td>26</td>
</tr>
<tr>
<td>Changing the size without altering the centerpoint</td>
<td>26</td>
</tr>
<tr>
<td>Starting drawing of a graphic from a centerpoint</td>
<td>27</td>
</tr>
<tr>
<td>Creating regular polygons</td>
<td>27</td>
</tr>
<tr>
<td>Aligning the centers of a number of objects</td>
<td>27</td>
</tr>
<tr>
<td>Arranging a number of objects -Using Snap to Grid-</td>
<td>28</td>
</tr>
<tr>
<td>Pasting a graphic created with commercial software</td>
<td>28</td>
</tr>
<tr>
<td>Using symbols</td>
<td>29</td>
</tr>
<tr>
<td>Changing the Measurement System for Numerical Values</td>
<td>29</td>
</tr>
<tr>
<td>Using a scanner to import an object</td>
<td>30</td>
</tr>
<tr>
<td>Importing bitmap data</td>
<td>31</td>
</tr>
<tr>
<td>Commands</td>
<td>32</td>
</tr>
<tr>
<td>Toolbar buttons</td>
<td>33</td>
</tr>
<tr>
<td>Command menus</td>
<td></td>
</tr>
<tr>
<td>[File] - [New...] command</td>
<td>34</td>
</tr>
<tr>
<td>[File] - [Open...] command</td>
<td>34</td>
</tr>
<tr>
<td>[File] - [Save] command</td>
<td>34</td>
</tr>
<tr>
<td>[File] - [Save As...] command</td>
<td>34</td>
</tr>
<tr>
<td>[File] - [Import...] command</td>
<td>34</td>
</tr>
<tr>
<td>[File] - [Import Text...] command</td>
<td>35</td>
</tr>
<tr>
<td>[File] - [Select Source] command</td>
<td>35</td>
</tr>
<tr>
<td>[File] - [Acquire...] command</td>
<td>35</td>
</tr>
<tr>
<td>[File] - [Print...] command</td>
<td>35</td>
</tr>
<tr>
<td>[File] - [Print Preview] command</td>
<td>35</td>
</tr>
<tr>
<td>[File] - [Print Setup...] command</td>
<td>35</td>
</tr>
<tr>
<td>[File] - [Preferences...] command</td>
<td>36</td>
</tr>
<tr>
<td>[File] - [Exit] command</td>
<td>36</td>
</tr>
<tr>
<td>Commands - [Edit] menu</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Undo] command</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Redo] command</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Copy] command</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Cut] command</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Copy] command</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Paste] command</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Delete] command</td>
<td>37</td>
</tr>
<tr>
<td>[Edit] - [Select All] command</td>
<td>37</td>
</tr>
<tr>
<td>Commands - [View] menu</td>
<td>37</td>
</tr>
<tr>
<td>[View] - [Zoom] - [Zoom In] command</td>
<td>38</td>
</tr>
<tr>
<td>[View] - [Zoom] - [Zoom Out] command</td>
<td>38</td>
</tr>
<tr>
<td>[View] - [Zoom] - [Custom...] command</td>
<td>38</td>
</tr>
<tr>
<td>[View] - [Grid Setup...] command</td>
<td>38</td>
</tr>
<tr>
<td>[View] - [Show Grid] command</td>
<td>38</td>
</tr>
<tr>
<td>[View] - [Grid Setup...] command</td>
<td>38</td>
</tr>
<tr>
<td>Commands - [Shape] menu</td>
<td>38</td>
</tr>
<tr>
<td>[Shape] - [Properties...] command</td>
<td>39</td>
</tr>
<tr>
<td>[Shape] - [Properties...] command</td>
<td>39</td>
</tr>
<tr>
<td>[Shape] - [Properties...] command</td>
<td>39</td>
</tr>
<tr>
<td>Commands - [Format] menu</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Font...] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Style] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Direction] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Line Alignment] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Line Spacing] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Character Spacing] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Make Stroke...] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Edit Stroke...] command</td>
<td>40</td>
</tr>
<tr>
<td>[Format] - [Properties...] command</td>
<td>40</td>
</tr>
<tr>
<td>Commands - [Object Info.] menu</td>
<td>40</td>
</tr>
<tr>
<td>[Object Info.] menu</td>
<td>40</td>
</tr>
<tr>
<td>[Object Info.] menu</td>
<td>40</td>
</tr>
<tr>
<td>Commands - [Shape] menu</td>
<td>41</td>
</tr>
<tr>
<td>[Shape] - [Properties...] command</td>
<td>41</td>
</tr>
<tr>
<td>[Shape] - [Properties...] command</td>
<td>41</td>
</tr>
<tr>
<td>[Shape] - [Properties...] command</td>
<td>41</td>
</tr>
<tr>
<td>Commands - [File] menu</td>
<td>42</td>
</tr>
<tr>
<td>[File] - [New...] command</td>
<td>42</td>
</tr>
</tbody>
</table>
If You Think There’s a Problem .............. 54
If You Think There's a Problem ......................... 55
Error Messages ......................................................... 55
Other symptoms ....................................................... 56
Appendixes ................................................................. 58
Operating Procedures of SFEdit .................................... 59
1 Names and functions ................................................. 59
2 Operation Procedures ............................................... 60
Step1: Choose the text ................................................. 60
Step2: Correct the shape of the character ...................... 60
Step3: Save the file ...................................................... 61
3 Basic Operations ....................................................... 62
4 Commands ............................................................... 65
Toolbar buttons ......................................................... 65
Commands - [File] menu ............................................. 66
Commands - [Edit] menu ............................................. 68
Commands - [View] menu .......................................... 69
Commands - [Shape] menu ......................................... 70
Commands - [Help] menu .......................................... 72
5 Error Messages ....................................................... 73
Glossary .................................................................. 74
Index ..................................................................... 75

Windows® and Windows NT® are registered trademarks or trademarks of Microsoft® Corporation in the United States and/or other countries.
TrueType is a trademark of Apple Computer, Inc.
Corel Draw is a trademark of Corel Corporation.

Copyright © 1999 ROLAND DG CORPORATION
* 

Introduction
Operating environment

Computer
Personal computer running Windows 95, Windows 98, or Windows NT® 4.0

CPU
If you're using Windows 95:
   i486SX or better (Pentium 100 MHz recommended)
If you're using Windows 98 or Windows NT 4.0:
   i486DX or better (Pentium 100 MHz recommended)

System Memory
If you’re using Windows 95:
   8 MB or more (10 MB or more recommended)
If you’re using Windows 98 or Windows NT 4.0:
   16 MB or more (32 MB or more recommended)

Hard Disk
10 MB or more of free space

Overview of Dr. Engrave

Dr. Engrave is a program for plate engraving that runs under Windows 95/98/NT.

Main Features of Dr. Engrave

- Support for multiple plates
  You can arrange a number of plates with the same design within the engraver’s cutting area. This makes it possible to make many plates efficiently.
  You can make a master plate, then make the settings for the number of plates laid out and their spacing. You can also divide a single plate.

- Import text files
  Text files with comma- or tab-separated values can be imported into text boxes. This lets you make use of files made using a spreadsheet or a database that can export data in text format.

- Fill feature
  Flat-drag machining can be performed for the center of text and graphics.

- Image contouring
  Image contours can be extracted and converted to line segments.
  Images can be entered by importing them from a TWAIN-compliant image scanner connected to the host computer, or by importing an image file saved in bitmap (BMP) format.
  You can also register a converted graphic as a symbol.

- Generation of stroke characters
  Characters with no line width (i.e., stroke characters) can be generated automatically from TrueType font characters. You can use such generated stroke fonts in Dr. Engrave in the same way as other fonts registered with Windows. (However, you can’t use them with other programs.)
  Text that has been changed to stroke characters can be engraved more rapidly than outline fonts, because the characters are made up of fewer line segments.
  You can also clean up such automatically generated stroke characters (stroke-character edit function).

- You can extract and display the contours of characters (for TrueType fonts).

- You can set characters (TrueType fonts) to the desired width (weight).

- You can create rectangles, circles, stars, polygons (polylines), and other graphics.

- Objects can be positioned with precision (snap-to-grid feature).
Starting the software

1. Click [Start].
   Point to [Roland Dr.Engrave] and click [Dr.Engrave].

2. The opening screen appears and Dr.Engrave starts.
Names and functions of screen items

(1) Title bar
The file name and program name are displayed here. The window can be moved by dragging the title bar.

(2) Menu Bar
Runs the various commands for Dr. Engrave.

(3) Toolbar
The toolbar is provided with buttons for running Dr. Engrave commands such as [Open...] and [Save]. Moving the mouse pointer over a button displays a brief description of the button’s function.

(4) Engraving area
This white square shows the engraving area (cutting area) set with the driver. An object that protrudes beyond this area is not engraved. The lower-left point of the engraving area is the origin point for Dr. Engrave, which coincides with the XY origin (home position) of the engraving machine.

(5) Origin point
This point (the lower-left point of the engraving area), is the origin point for Dr. Engrave. This coincides with the XY origin (home position) for the engraving machine.

(6) Object Information Bar
This shows the location of the mouse pointer, as well as the centerpoint, size, angle, and slant of the object. This doesn’t appear when more than one plate is laid out.

(7) Status Bar
This shows Dr. Engrave’s state of operation and provides brief descriptions of commands. This also shows line color and amount of zoom in or zoom out for the image.

(8) Object
This is a shape or a block of text to be engrave.

(9) Popup menu
Clicking the right mouse button within an editing area makes a menu appear. The displayed menu varies according to the type of selected object or present mode.

(10) When the mouse pointer is moved close to here, the pointer changes to a diagonal arrow. You can then change the window size by dragging.

(11) Minimize button
This shrinks the window to a button on the taskbar.

(12) Maximize button
This expands the window to fill the screen.

(13) Close button
This ends the program. If changes made to the file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.
1

Operation Procedures
Introduction

This section explains the basic operation of Dr. Engrave, taking the engraving of the plate shown in the figure as an example to describe each step.

Step 1: Enter the workpiece size

Set the engraving area to match the size of the workpiece loaded. The engraving range that has been set becomes the editing area for Dr. Engrave. The editing area is represented by a shadowed white rectangle. A plate is designed by arranging shapes and text in the editing area. Portions that extend beyond this area are not engraved.

1. From the [File] menu, click [Print Setup...].
   The [Print Setup] dialog box is displayed.
2. For [Printer], click [Name], then choose the driver to be used for output.

   ![Print Setup Dialog Box]

   - Name: Roland CAMM-2 PNC-2301A  
   - Properties

3. Click [Properties].
   The driver’s properties open.
4. Enter the cutting area (engraving area).
   In this example, enter a range with vertical size of 40 mm and a horizontal size of 60 mm.

   ![Cutting Area]

   - Width: 60.0
   - Length: 40.0

5. Leave the Properties screen displayed and carry out the next steps.
Step 2: Set the cutting conditions

Make the settings for the blade's movement speed, cutting-in amount, and other cutting conditions to match the composition and thickness of the loaded workpiece and the type of blade. For cutting conditions such as Z0 that can't be set with the driver, make the settings directly on the engraving machine.

This section gives an overview of the steps when engraving all graphics and text at the same depth. For more details about the cutting-condition settings, see the help screens for the driver.

1. At the driver's Properties, click the [Tool] tab.
2. Enter the feed rate for [X/Y Speed] and [Z Speed].

   \[
   \begin{array}{c|c}
   \text{X/Y Speed} & \text{Z Speed} \\
   \hline
   \text{[mm/s]} & \text{[mm/s]} \\
   \end{array}
   \]

   When the feeding speed is high, processing becomes rough and flash marks tend to remain on the cut surface. On the other hand, when the feeding speed is slow, processing takes more time. Be careful because a slower feeding speed does not always result in improved finishing. Set a feed rate that is optimal for the composition of the workpiece being engraved as well as the composition and diameter of the blade.

3. Enter the values for [Z Up Position] and [Z Down Position]. The figure below shows a case where Z0 is set at the workpiece surface.

   \[
   \begin{array}{c|c}
   \text{Z Up Position} & \text{Z Down Position} \\
   \hline
   \text{[mm]} & \text{[mm]} \\
   \end{array}
   \]

4. Enter the value for [Z Engraving Pitch].

   \[
   \begin{array}{c|c}
   \text{Z Engraving Pitch} \\
   \hline
   \text{[mm]} \\
   \end{array}
   \]

   When the cutting-in amount is deeper, the cutting speed increases, but the cutting-in amount is limited by the quality of the workpiece. In cases where the required depth cannot be cut at once, repeat cutting several times to depth that does not breach the limit.

5. Click [OK].

   The click [OK] again to close the [Print Setup] dialog box.

Step 3: Enter the text

Enter the block of text to be engraved. The text that is input is displayed as outlined text. Dr. Engrave can use TrueType fonts registered with Windows as well as stroke fonts that you create yourself.

Here we'll input Robert as the block of text and set Times New Roman.

1. Click the button.
2. Click at the start point for entering the text.
3. Type in Robert from the keyboard.
4. Click the button.
5. From the [Format] menu, click [Font...]. The [Font Select] dialog box is displayed.
6. Click on the font name to select it and click [OK]. Here, we'll select Times New Roman.
7. Drag one of the points ( ) around the text string to change the size of the text string. To enlarge or reduce the size of the text string at a uniform scale, hold down the [Shift] key while dragging.
8. Drag the text string to position it at the desired location. In this example, the text string is positioned as shown the figure.
Step 4: Draw graphics

Add graphics to the data. In this example we’ll draw a narrow rectangle.
In addition to regular rectangles, Dr. Engrave can draw rounded-corner rectangles, circles and ellipses, stars, and polygons (polyline).

1. Click the button.
   The mouse pointer changes from the selection tool ( ) to the shape-drawing tool ( ).
2. Drag the pointer as shown in the figure.

Step 5: Import an image file

You can import existing image data, extract the contours, and convert the data to line segments.
For instance, it's possible to include the logo data for a company or organization in a plate.
This section explains the steps in converting an image file you've already acquired with a scanner (in Windows bitmap format) to line segments.

1. From the [File] menu, click [Import...].
   The [Open] dialog box appears.
2. Click [Files of type] and select [Windows Bitmap File (*.bmp)].
   A list of files that can be imported is shown.
3. Select the desired file and click [Open].
4. The data is read into the preview screen and displayed. Check the contents and click [OK].
   When importing a color image, outlining may not proceed as expected, depending on the colors. In such cases, drag the [Adjust Image Density] slider to adjust the image, or refer to the "Importing bitmap data " to correct the data using a commercial software application.
5. The outlined object appears on screen.

6. Click the button.
7. Click on the object to select it.
8. Drag one of the points ( ) around the object to change the size of the object.
   To enlarge or reduce the size of the object at a uniform scale, hold down the [Shift] key while dragging.
9. Drag the object to position it at the desired location.
   In this example, the object is positioned as shown the figure.
Step 6: Save the file

Save the data that's been created to a file.

1. Click the 
   button.
   The [Save As] dialog box appears.
2. Specify where to save the file.
3. Enter the name of the file and click [Save].

Step 7: Start engraving

Output the data and start engraving.
Before starting engraving, check the cable connections, the loaded position of the workpiece, the installed blade, and the setting for the origin. For more information, take a look at the user's manual for the engraving machine.

1. Click the 
   button.
   The [Print] dialog box appears.
2. Click [OK].
   The engraving data is sent to the engraving machine, and engraving starts.

To cancel engraving before it's finished

1. Pause the engraving machine.
   For more information, take a look at the user's manual for the engraving machine.
2. On the Windows, click [Start].
3. Point to [Settings] and click [Printers].
4. Double-click the icon for the printer driver.
5. From the [Printer] menu, click [Purge Print Jobs].
   The file being engraved is deleted from the list. If the file being engraved isn't shown, it means that the sending of data has already ended.
6. Operate the engraving machine to end the task.
   For more information, take a look at the user's manual for the engraving machine.
Basic Operations for Objects
Selecting an object

1. Click the \[\text{button}\].
2. Move the mouse cursor to the object to be selected, and click the mouse.
3. The symbols □ and △ appear around the selected object. When an object is chosen, pressing the [Tab] key selects a different object. To invert the object selection order, hold down the [Shift] key and press [Tab].

Selecting more than object
- While holding down the [Shift] key, click on each of the objects you wish to select.
- Drag the mouse to enclose entirely the object you wish to select.

Canceling the selection of an object

1. Click the \[\text{button}\].
2. Click on an area other than the selected object.

Moving an object horizontally or vertically

1. Click the \[\text{button}\].
2. Click on the object to select it.
3. While holding down the [Shift] key, drag the object up, down, or to the left or right.

Making an object larger or smaller

1. Click the \[\text{button}\].
2. Click on the object to select it.
3. Change the size of the object by dragging the points (□ and △) that appear around the object.

The size can be freely changed by dragging a square point (□). The size can be changed while maintaining the shape's vertical and horizontal aspect by holding down the [Shift] key while dragging.

The triangular points (△) on the left and right can be dragged to change the horizontal size.

The triangular points (△) above and below can be dragged to change the vertical size.

Rotating an object

1. Click the \[\text{button}\].
2. Click on the object to select it.
3. Click on the object again.
4. Drag a circular point (●) to rotate the object.
Slanting an object

* Text boxes cannot be slanted.

1. Click the \[\text{ }\] button.
2. Click on the object to select it.
3. Click on the object again.
   The diamond point ( ) appears.
   In the case of a text string, a slant bar appears.
4. Drag a diamond point ( ) to slant the object.

For a text string, drag one of the points ( ) for the slant bar.

Deleting an object

1. Click the \[\text{ }\] button.
2. Select the object to be deleted by clicking on it.
3. From the [Edit] menu, click [Delete].

Selecting a vertex of a polygon (polyline)

1. Click the \[\text{ }\] button.
2. Click on the polygon (polyline).
3. Click on the point.
   The selected point changes to a square with a border ( ).
   When a vertex is chosen, pressing the [Tab] key selects a different vertex. To invert the vertex selection order, hold down the [Shift] key and press [Tab].

Selecting multiple vertices of a polygon (polyline)

1. Click the \[\text{ }\] button.
2. Click on the polygon (polyline).
3. Hold down the [Shift] key and click on each point ( ).
   Alternatively, drag the mouse over the points to be selected.
   Each selected point changes to a square with a border ( ).

Copying an object

1. Click the \[\text{ }\] button.
2. Select the object to be copied by clicking on it.
3. Click the \[\text{ }\] button.
4. Click the \[\text{ }\] button.
   The new object is copied overlapping the source object.
5. Select the copied object and drag it to the desired location.
Selecting all vertices of a polygon (polyline)

1. Click the button.
2. Click on the polygon (polyline).
3. While holding down the [Ctrl] key, click on one point ( ).
   All vertices contained in the polygon (polyline) change to squares with borders ( ).

Adding a vertex to a polygon (polyline)

1. Click the button.
2. Click on the polygon (polyline).
3. Move the mouse pointer over a line of the polygon, then click.
   A ( ) appears where the point will be added.
4. From the [Shape] menu, click [Insert Vertex].
   You can also double-click on a line in a graphic and add a vertex.

Moving a vertex of a polygon (polyline) horizontally or vertically

1. Click the button.
2. Click on the polygon (polyline).
3. Hold down the [Shift] key and drag the vertex ( ) up, down, or to the left or right.

Deleting a vertex of a polygon (polyline)

1. Click the button.
2. Click on the polygon (polyline).
3. Click on the point.
   The selected point changes to a square with a border ( ).
   To delete two or more points at the same time, hold down the [Shift] key as you click on each point ( ). Alternatively, drag the mouse over the points to be deleted.
4. From the [Shape] menu, click [Delete Vertex].
3

Hints and Tips
About the origin point for engraving

The following figure shows the origin point for Dr. Engrave. The location of the origin point is always at the lower-left point of the engraving area, and cannot be changed.

The origin point for Dr. Engrave coincides with the XY origin (home position) of the engraving machine.

Changing the engraving depth

To change the depth of engraving for each object, change the line (or fill) color. The depths of the various colors can be set with the driver for the engraving machine. For more information about how to make the settings, see the help screens for the driver.

To change an object's line (or fill) color, follow the steps below.

1. Click the button.
2. Click on the object to select it.
3. From the [Shape] menu, click [Properties]. The Properties dialog box for the selected object appears.
4. Click the drop-down arrow next to [Color], then click the desired color.

Related Topics
Text String Properties
Shape Properties
Polygon Properties
Text Box Properties
Arranging plates of the same size for engraving at one time

This section describes how to line up cut plates of the same size on the engraving machine’s cutting table and engrave them at one time.

In this section, four plates measuring 60 mm x 40 mm (2.4 x 1.5 inch) are mounted on a base measuring 150 mm x 100 mm (6 x 4 inch), and the plates are changed to engrave a total of eight plates. To make it easy to understand, the procedure described here is broken down into three steps.

Step 1: Make a template file
Step 2: Arrange the plates and enter the text
Step 3: Ready the engraving machine and start engraving

1. From the [File] menu, click [New…].
   The [New File] dialog box appears.
2. Click the [Standard] tab, then click [New File].

3. Click [Template] to activate it, then click [OK].

   ![Template Properties dialog box]

   The [Template Properties] dialog box appears.

4. Enter the plate size, then click [OK].
   In this example, enter the values shown below.

   ![Plate size input]

   An empty file with no entries is opened.

5. Click and create the text box shown in the figure.

6. Make the settings for the size of the text in the text box, the font type, and so on. You can also make the settings after laying out the plates. In that case, from the [Layout] menu, use [Edit Template]. In this example, the text settings are made ahead of time.

   Choose a text box, then from the [Shape] menu, click [Properties].

7. Make the settings for the text size and layout, font type, and other necessary items, then click [OK]. Normally, you should set the size of the text so that it doesn't exceed the size of the text box.

8. Click to make the rectangle shown in the figure.

9. Import the image file shown in the figure.
   For more information, see Importing bitmap data or Using a scanner to import an object.

10. Click and save the file.
Step 2: Arrange the plates and enter the text

Arrange the plates you created in Step 1, then enter the text in the text box.

2. Make the settings as shown in the figure, then click [OK].
3. Enter the size of the base where the plates are mounted. From the [File] menu, click [Print Setup…]. The [Print Setup] dialog box appears.
4. Click [Properties]. The driver's properties open.
5. Enter the size of the base in the engraving area, then click [OK]. In this example, enter the values shown below.
6. Click [OK] to close the [Print Setup] dialog box.
7. Click the button.
8. Click on the text box and enter the text. In this example, enter the text shown below.
9. Click [Next] on the layout information bar to display the second page.
10. Click on the text box and enter the text. In this example, enter the text shown below.
11. Click and save the file.

Related Topics
Importing a text file into a text box
Step 3: Ready the engraving machine and start engraving

Install a blade and load a workpiece on the engraving machine, and start cutting.

1. Install a blade and load a workpiece on the engraving machine.
   Mount the base on the engraving machine’s cutting table, and load the workpiece at the location shown in the figure. For more information, take a look at the user’s manual for the engraving machine.

2. Operate the engraving machine to set Z0 at the surface of the workpiece.
   Also, set the home position (XY origin point) at the lower-left point of the base. For more information, take a look at the user’s manual for the engraving machine.

3. Click the button.
   The [Print] dialog box appears.

4. Make the settings for the blade’s movement speed, cutting-in amount, and other cutting conditions to match the composition and thickness of the loaded workpiece and the type of blade. Click [Properties]. The driver’s properties open.

5. Click [Tool] tab.

   ![Image showing settings](image)

6. Enter the feed rate for [X/Y Speed] and [Z Speed].
   When the feeding speed is high, processing becomes rough and flash marks tend to remain on the cut surface. On the other hand, when the feeding speed is slow, processing takes more time.
   Be careful because a slower feeding speed does not always result in improved finishing.
   Set a feed rate that is optimal for the composition of the workpiece being engraved as well as the composition and diameter of the blade.

7. Enter the values for [Z Up Position] and [Z Down Position].

8. Enter the value for [Z Engraving Pitch].
   When the cutting-in amount is deeper, the cutting speed increases, but the cutting-in amount is limited by the quality of the workpiece. In cases where the required depth cannot be cut at once, repeat cutting several times to depth that does not breach the limit.

9. Click [OK] to close the driver’s properties.

10. Click [OK].
    The engraving data is sent to the engraving machine, and engraving starts.

11. When output of the first page of engraving data ends, a message appears to prompt you to change the workpiece. Make sure the operation of the engraving machine has stopped, then load a new workpiece on the base. Load the workpiece in the same location as shown in the figure in 1 above. If necessary, set Z0 at the surface of the loaded workpiece again.

12. After loading the workpiece, click [OK]. The second page of engraving data is sent to the engraving machine, and cutting starts.

Related Topics
Re-engraving a desired plate
Dividing a single plate to create multiple plates

This section describes how to place a single plate on the engraving machine's cutting table and engrave a number of plates while dividing the loaded plate. In this section, four identical copies of a design measuring 60 mm x 40 mm (2.4 x 1.5 inch) are engraved on a plate measuring 150 mm x 100 mm (6 x 4 inch). To make it easy to understand, the procedure described here is broken down into three steps.

Step 1: Make a template file
Step 2: Arrange the plates and enter the text
Step 3: Ready the engraving machine and start engraving

Step 1: Make a template file

Create the data for a single plate and save it as a template file.

2. Click the [Standard] tab, then click [New File].
3. Click [Template] to activate it, then click [OK]. The [Template Properties] dialog box appears.
4. Enter the plate size, then click [OK]. In this example, enter the values shown below.
   - Size: 150 mm x 100 mm
   - A blank file with no entries is opened.
5. Click and create the text box shown in the figure.
6. Make the settings for the size of the text in the text box, the font type, and so on. You can also make the settings after laying out the plates. In that case, from the [Layout] menu, use [Edit Template]. In this example, the text settings are made ahead of time.
7. Make the settings for the text size and layout, font type, and other necessary items, then click [OK]. Normally, you should set the size of the text so that it doesn't exceed the size of the text box.
8. Click to make the rectangle shown in the figure.
9. Import the image file shown in the figure. For more information, see Importing bitmap data or Using a scanner to import an object.
10. Click and save the file.
Step 2: Arrange the plates and enter the text

Arrange the plates you created in Step 1, then enter the text in the text box.

2. Make the settings as shown in the figure, then click [OK].

3. Enter the distance between plates lower-left point and origin point.
   Enter the number of plates laid out.
   Activate to cut dividing lines.
   Changes the color in order to differentiate the depth of text and graphics from the depth of the dividing line.

4. Enter the size of the entire plate to be engraved.
   From the [File] menu, click [Print Setup…]. The [Print Setup] dialog box appears.
5. Click [Properties]. The driver’s properties open.
6. Enter the size of the plate in the engraving area, then click [OK].
   In this example, enter the values shown below.

7. Click [OK] to close the [Print Setup] dialog box.
8. Click on the text box and enter the text. In this example, enter the text shown below.

9. Click and save the file.

Related Topics
Importing a text file into a text box

Step 3: Ready the engraving machine and start engraving

Install a blade and load a workpiece on the engraving machine, and start cutting.

1. Install a blade and load a workpiece on the engraving machine.
   For more information, take a look at the user’s manual for the engraving machine.
2. Operate the engraving machine to set Z0 at the surface of the workpiece.
   Also, set the home position (XY origin point) at the lower-left point of the workpiece.
   For more information, take a look at the user’s manual for the engraving machine.
3. Click the button.
   The [Print] dialog box appears.
4. Make the settings for the blade’s movement speed, cutting-in amount, and other cutting conditions to match the composition and thickness of the loaded workpiece and the type of blade. Click [Properties].
   The driver’s properties open.
5. Click [Tool] tab.
6. The color of the graphic and text lines is set to black, and the color of the dividing lines is set to red.
   Set different cutting conditions for the respective colors.
7. Click on a black tab and specify a tool number.
8. Enter the feed rate for [X/Y Speed] and [Z Speed].

   ![Feed Rate](image)

   When the feeding speed is high, processing becomes rough and flash marks tend to remain on the cut surface. On the other hand, when the feeding speed is slow, processing takes more time.
   Be careful because a slower feeding speed does not always result in improved finishing.
   Set a feed rate that is optimal for the composition of the workpiece being engraved as well as the composition and diameter of the blade.
9. Enter the values for [Z Up Position] and [Z Down Position].

   ![Position](image)

   When the cutting-in amount is deeper, the cutting speed increases, but the cutting-in amount is limited by the quality of the workpiece. In cases where the required depth can not be cut at once, repeat cutting several times to depth that does not breach the limit.
10. Enter the value for [Z Engraving Pitch].

   ![Pitch](image)

   When the cutting-in amount is deeper, the cutting speed increases, but the cutting-in amount is limited by the quality of the workpiece. In cases where the required depth can not be cut at once, repeat cutting several times to depth that does not breach the limit.
11. Set the cutting conditions for the dividing lines.
    Click on a red tab and specify a tool number.
12. Make the settings for steps 8 through 11.
    For [Z Down Position], enter 1.8 mm.
13. To replace the blade while engraving is PAUSE, activate [Pause for Tool Change].
14. Click [OK] to close the driver’s properties.
15. Click [OK].
    The engraving data is sent to the engraving machine, and engraving starts.

   ![Pause](image)

   Re-engraving a desired plate

   ![Related Topics](image)
Re-engraving a desired plate

This section describes how to re-engrave a desired plate after laying out and engraving a number of plates. At such times as when a portion of the engraving is unsuccessful, or when engraving is carried out without noticing that text entry has failed, you can select only the unsuccessful plate and carry out engraving again.

1. Open the desired file.
2. Click the page-selection buttons on the layout information bar to display the page that includes the plate you want to modify.
3. Correct the data.
4. Click the button.
5. Click on the plate to be reworked. The plate’s contour is selected and its color changes to blue. To choose a number of plates, hold down the [Shift] key as you click on the plates.
6. Install a blade and load a workpiece on the engraving machine. For more information, take a look at the user’s manual for the engraving machine.
7. Click the button.
8. Make the settings for the size of the text in the text box, the font type, and so on. Normally, you should set the size of the text so that it doesn’t exceed the size of the text box.
9. Click [OK]. The engraving data for only the specified plate is sent to the engraving machine, and engraving starts.

Importing a text file into a text box

This section how to take text data created with a spreadsheet or database and import it into a text box.

1. Use a spreadsheet or database to make a text file containing the data to be imported into the text box. Choose commas or tabs as the field separators. Dr. Engrave cannot recognize any separators other than these. For more information, refer to the documentation for the spreadsheet or database.
2. Open a template file that contains a text box.
3. Make the settings for the size of the text in the text box, the font type, and so on. You can also make these settings after importing the text. In that case, from the [Layout] menu, use [Edit Template]. In this example, the text settings are made ahead of time. Choose a text box, then from the [Shape] menu, click [Properties].
4. Make the settings for the text size and layout, font type, and other necessary items, then click [OK].
5. Click [ ] and save the template file.
7. Enter the necessary layout information. It’s not necessary to lay out the same number of plates as the number of records. The number of plates is adjusted to be the same as the number of records when the records are imported.
8. Click [OK]. The Template Layout mode is enabled.
9. From the [File] menu, click [Import Text…].
10. Choose the text file you prepared in step 1, then click [OK]. The [Open] dialog box appears.
11. Choose the text file you prepared in step 1, then click [OK].
12. Click on the field separator, then click [Next].
13. Specify the type of field data to import into the text box. Drag the text in the field over the text box where you want to import it. When you’re done making the settings, click [Next].
14. Choose the record to import into the text box. To import all records, click [Select All].
15. When you’re done specifying records, click [Finish]. The data in the text file is entered in the text box.
Speeding up text engraving

Text that has been changed to stroke characters can be engraved more rapidly than outline fonts, because the characters are made up of fewer line segments.

1. Choose a text string to convert to stroke characters.
2. From the [Shape] menu, click [Make Stroke...].
   The [Select Stroke Font] dialog box appears.
3. Click the drop-down arrow for [Stroke Font Name] and choose a font, then click [OK].
   To register a new stroke font, click the text box and enter the name of the new font.
4. The text is laid out on screen as stroke characters.

Related Topics

[Format] - [Edit Stroke...] command

Changing the size without altering the centerpoint

To change the size without altering the position of its centerpoint, hold down the [Ctrl] key and drag an editing point ( ■ or ▲).

1. Select the object.
2. While holding down the [Ctrl] key, drag a point ( ■ or ▲).
   The size can be freely changed by dragging a square point ( ■).
   The size can be changed while maintaining the shape's vertical and horizontal aspect by holding down the [Shift] key while dragging.

The triangular points ( ▲ ) on the left and right can be dragged to change the horizontal size.

The triangular points ( ▲ ) above and below can be dragged to change the vertical size.

Related Topics

Making an object larger or smaller

Creating shapes (such as circles and squares) with a vertical/horizontal aspect of 1:1

To create a shape with a vertical/horizontal aspect of 1:1, such as a circle or square, drag while holding down the [Shift] key.
This function is not supported when creating text or a polygon.

1. Click the button for creating a rectangle, round rectangle, circle or ellipse, or star.
2. While holding down the [Shift] key, drag the object.

Related Topics

Making an object larger or smaller
Text String Properties [Keep Aspect for input]
Polygon Properties [Keep Aspect for input]
Starting drawing of a graphic from a centerpoint

To create a shape with a shape's start point the centerpoint, drag while holding down the [Ctrl] key.
This function is not supported when creating text or a polygon.

1. Click the button for creating a square, rounded-corner square, circle or ellipse, or star.
2. While holding down the [Ctrl] key, drag the object.

Related Topics
Creating shapes (such as circles and squares) with a vertical/horizontal aspect of 1:1

Aligning the centers of a number of objects

When arranging a text string at the center of a rectangle, or when create concentric circles, use the [Layout] menu's [Align] command.

1. Create the objects at any location.
2. Select all of the objects whose centers you wish to align.
3. From the [Layout] menu, click [Align].
The centers of the selected objects are aligned.
If you have selected a number of objects while holding down the [Shift] key, the objects are overlaid atop the last object you chose. If you've selected a number of objects by dragging an area, the objects are overlaid atop the object in the foreground.

Creating regular polygons

A regular polygon can be created by first making a circle, then modifying it.

1. Click the button.
2. While holding down the [Shift] key, drag the mouse to create a circle.
3. Select the circle, then from the [Shape] menu, click [Properties].
The [Shape Properties] dialog box appears.
4. Drag the [Shape] slider.
   You can make any regular polygon having from three sides (an equilateral triangle) to thirteen. Dragging the slider to the right-hand edge creates a circle instead of a polygon.
Arranging a number of objects -Using Snap to Grid-

It's possible to use a grid as a guide for placing and sizing objects. The grid is shown on screen with equal vertical and horizontal spacing. When Dr. Engrave has just been installed, the grid is not shown.

To align an object with the grid, from the [View] menu, activate [Snap To Grid].

1. Create the object at any location.
2. At the [View] menu, click [Show Grid] to activate it.
3. At the [View] menu, click [Snap To Grid] to activate it.
4. Select the objects one at a time, and move each object toward the grid at the desired location. The object is automatically pulled to the grid and aligned.

When the rectangles are aligned with the left-hand edge

Changing the point where an object snaps to the grid

The snap point is initially at an object's lower left.

To change the snap point, hold down the [Ctrl] key and click on the desired point.

The snap point can be a point around the perimeter of the object (any of eight points) or a point at the center of the object.

You can use this feature to align a number of objects at their centers or their upper-right points, for example.

Pasting a graphic created with commercial software

You can copy data created with software such as CorelDRAW! that uses vector data, and paste the data into Dr. Engrave using the clipboard. The data pasted in can then be edited just like any ordinary object.

Conditions for data that can be pasted
- Don't include bitmap data
- Don't fill or apply shading inside shapes
- Set line width to the finest (narrowest) available setting

1. After using a commercial software application to create data, select the data and copy it.
2. From the [Edit] menu, click [Paste].

The copied data appears in Dr. Engrave.

Related Topics
[Grid Setup...] command
Aligning the centers of a number of objects
Using symbols

Dr. Engrave is provided with a set of symbols. Symbols can be added to a file being edited, or registered with Dr. Engrave objects.

Importing a symbol
1. From the [Shape] menu, click [Symbol]. The [Symbol] dialog box appears.
2. Select the group, then click on the symbol to be added.
3. Click [Insert]. The chosen symbol (object) is laid out on screen.
4. Adjust the size and position of the symbol to be placed.

Registering a symbol
1. Select the object to be registered a symbol.
2. From the [Shape] menu, click [Add Symbol]. The [Add Symbol] dialog box appears.
3. Register the symbol with an appropriate group according to use or shape.
   To create a new group, click [New Group] and enter a name for the group. When adding the symbol to an existing group, select the group name with [Group Name].
4. At [Symbol Name], enter a name for the symbol. Then click [Add].

Changing the Measurement System for Numerical Values

The measurement system used for numerical values depends on the unit setting for Windows in effect when Dr. Engrave starts up. The settings for Windows can be changed with [Measurement System] on the [Number] tab under [Control Panel] - [Regional Setting].

If the measurement system has been changed, Dr. Engrave must be stopped and restarted for the new setting to take effect.
Using a scanner to import an object

An image acquired with a scanner can be imported into Dr. Engrave and outlined for engraving. Dr. Engrave supports scanners that comply with TWAIN_32. For information on connecting the scanner and installing the scanner driver, please refer to the scanner's documentation.

There are some images whose outlines cannot be extracted. Please keep the following conditions in mind when creating data.

Conditions for data allowing extraction of clear outlines
- Boundaries between two colors should be sharp and well defined, with no continuous gradations. Using only the two values of white and black is recommended. Scanned data for photographs generally contains continuous gradations, making it unsuitable for outlining.

<Example>

- The scan resolution should be high. In general, a higher resolution yields outlining of greater accuracy. The optimal resolution varies according to a shape's complexity and size when cut. However, it takes longer to import high-resolution data into Dr. Engrave than low-resolution data.

<Example>

- The size of the original art being scanned should be the same as the size when engraving. Results of engraving that are more attractive than the original art are not obtained when an image smaller than the engraved image is imported and then enlarged with Dr. Engrave. To help ensure attractive results of engraving, start with a larger object and reduce it to the desired size.
Importing bitmap data

Dr. Engrave can import image files in Windows bitmap format (with a file extension of *.bmp), then outline (extract the contours) of the imported data or paste it as a polygon (polyline). For information on how to save a file in Windows bitmap format, please refer to the documentation for the software application.

There are some images whose outlines cannot be extracted. Please keep the following conditions in mind when creating data.

Conditions for data allowing extraction of clear outlines
- Boundaries between two colors should be sharp and well defined, with no continuous gradations.
  Using only the two values of white and black is recommended. Scanned data for photographs generally contains continuous gradations, making it unsuitable for outlining.
  <Example>

- The scan resolution should be high.
  In general, a higher resolution yields outlining of greater accuracy. The optimal resolution varies according to a shape's complexity and size when cut. However, it takes longer to import high-resolution data into Dr. Engrave than low-resolution data.
  <Example>

- The size of the original art being scanned should be the same as the size when engraving.
  Results of engraving that are more attractive than the original art are not obtained when an image smaller than the engraved image is imported and then enlarged with Dr. Engrave. To help ensure attractive results of engraving, start with a larger object and reduce it to the desired size.

1. From the [File] menu, click [Import...].
   The [Open] dialog box appears.
2. Click [Files of type] and select [Windows Bitmap File (*.bmp)].
   A list of files that can be imported is shown. Select the desired file and click [Open...].
3. The data is read into the preview screen and displayed. Check the contents and click [OK].
   When importing a color image, outlining may not proceed as expected, depending on the colors. In such cases, drag the [Adjust Image Density] slider to adjust the image, or refer to the "Conditions for data allowing extraction of clear outlines" to correct the data using a commercial software application.
4. The outlined object appears on screen.

Related Topics
[Import...] command
4

Commands
Toolbar buttons

The toolbar is provided with buttons for running Dr. Engrave commands such as [Open...], [Save], and [Open...]. Moving the mouse pointer over a button displays a brief description of the button's function.

- ![File](image1) This creates a new file.
- ![Open](image2) This opens a Dr. Engrave file.
- ![Save](image3) This saves the file, overwriting the previous version of the file.
- ![Import](image4) This takes the engraving data displayed on the edit screen and outputs it to the engraving machine.
- ![Delete](image5) This deletes the selected object, and copies it to the clipboard.
- ![Copy](image6) This copies the selected object to the clipboard.
- ![Paste](image7) This copies the contents of the clipboard, pasting them at the selected on-screen location.
- ![Select](image8) This selects an object.
- ![Select](image9) This is used to reposition the vertices of a polygon (polyline), changing its shape.
- ![Select](image10) This enlarges or reduces the view of the object.
- ![Select](image11) This is used to enter a block of text to be engrave.
- ![Select](image12) This is used to create a square or rectangle by dragging to the desired location.
- ![Select](image13) This is used to create a square or rectangle with rounded corners by dragging to the desired location.
- ![Select](image14) This is used to create a circle or ellipse by dragging to the desired location.
**Commands - [File] menu**

[File] - [New...] command

This creates a new file.
Clicking the toolbar button creates a new document file empty of graphics or text strings. At the [File] menu, clicking [New] displays the [New File] dialog box.

If changes made to a file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.

- **Keyboard shortcut:** [Ctrl]+[N]

### [New File] dialog box

1. **Tab**
   - The tab shows the group name for the template file.
   - The template files (*.det) in Dr. Engrave's [Template] folder appear on the [Standard] tab.
   - To add a new group, create another folder one level below the [Template] folder. The name of the folder you've created uses the tab name (group name) without change. Note that folders two or more levels below the [Template] folder are not displayed.

2. **This displays a list of the template files included on the tab you selected.
   - To create a new file empty of graphics or text strings, at the [Standard] tab choose [New File].
   - To create a new document file (*.ded), make [Document] active. To create a new template file (*.det), make [Template] active.

3. **Preview**
   - This displays the contents of the template file you've selected.

4. **Document**
   - This copies the contents of the selected template file and creates a new document file.
   - To create a new document file (*.ded) empty of graphics or text strings, at the [Standard] tab choose [New File].

5. **Template**
   - This copies the contents of the selected template file and creates a new template file.
   - To create a new template file (*.det) empty of graphics or text strings, at the [Standard] tab choose [New File].

[File] - [Open...] command

This opens a Dr. Engrave file.
Running this command opens the [Open] dialog box.
If changes made to a file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.

- **Keyboard shortcut:** [Ctrl]+[O]

[File] - [Save] command

This saves the file, overwriting the previous version of the file.
To save the file with a different name or in a different area, use the [Save As...] command.

- **Keyboard shortcut:** [Ctrl]+[S]

[File] - [Save As...] command

This saves the file with a different name.
Running this command opens the [Save As] dialog box.

[File] - [Import...] command

This imports a file created using another software application.
Running this command makes the [Open] dialog box appear.

**Related Topics**

- Importing bitmap data
[File] - [Import Text...] command

This imports a comma- or tab-separated text file into a text box. This lets you make use of files made using a spreadsheet or a database that can export data in text format. This command is available only when multiple plates have been laid out.

Running this command displays the [Open] dialog box. Choose a file and click [OK] to call up the [Text Import] wizard. Follow the messages that the [Text Import] wizard shows to complete the procedure.

- Related Topics
  - Importing a text file into a text box

[File] - [Select Source] command

This selects the scanner connected to the computer. Dr. Engrave supports scanners that comply with TWAIN_32. For information on connecting the scanner and installing the scanner driver, please refer to the scanner's documentation. If a TWAIN driver and a TWAIN_32 driver are both installed, choose the TWAIN_32 driver.

- Related Topics
  - Using a scanner to import an object

[File] - [Acquire...] command

This takes in the image from the scanner. The acquired image is outlined and converted to graphics. Running this command launches the software for performing scanning. For more information on operation, please refer to the scanner's documentation.

- Related Topics
  - Using a scanner to import an object

[File] - [Print...] command

This takes the engraving data displayed on the edit screen and outputs it to the engraving machine. Running this command opens the [Print] dialog box. To output data, then for [Printer], click on the down-pointing arrow next to [Name], then click on the driver to be used for output. At the [Print] dialog box you can make settings for the items such as the printing range and number of copies. To make settings for the engraving area (workpiece size) or the cutting conditions (tool speed, depth, and so on), click [Properties]. For more information on the Properties settings, refer to the help screens for the driver.

- Keyboard shortcut: [Ctrl]+[P]

[File] - [Print Preview] command

This displays what the results of printing will look like, so you can check your work before actually performing printing. Running this command changes the display from the object's edit screen to the preview screen.

Preview screen commands
- Print... This performs printing. The [Print] dialog box appears.
- Page Setup... This allows you to make settings for paper size, margins, and the like. The [Page Setup] dialog box appears.
- Zoom In This enlarges the view size of the print image.
- Zoom Out This reduces the view size of the print image.
- Close This closes the Preview screen for printing.

[File] - [Print Setup...] command

This is used to select the driver. The [Print Setup] dialog box appears. To output data, then for [Printer], click on the down-pointing arrow next to [Name], then click on the driver to be used for output. To make settings for the engraving area (workpiece size) or the cutting conditions (tool speed, depth, and so on), click [Properties]. For more information on the Properties settings, refer to the help screens for the driver. The settings made here are temporarily saved. The changes are lost when you quit Dr. Engrave.
**[File] - [Preferences...] command**

This sets the default font and text height when entering text, the screen color scheme, and the zoom ratio.

Running this command displays the [Preferences] dialog box.

**[Preferences] dialog box**

1. **Text**
   - This chooses the default settings of the text string or the default settings of the text box.

2. **Text Height**
   - This is for entering the default value for text height.

3. **Choose the portion of the text for which you want to enter the height.**

4. **Font**
   - This sets the default font used when entering text.

5. **Sheet color**
   - This determines the color of the engraving area.
   - To specify a color other than one of the selections shown, click [Other]. This displays the [Color] dialog box.

6. **Background color**
   - This determines the background color for the engraving area.
   - To specify a color other than one of the selections shown, click [Other]. This displays the [Color] dialog box.

7. **Zoom ratio**
   - This determines the zoom ratio used when Dr. Engrave starts.

---

**[File] - [Exit] command**

This ends the program.

If changes made to the file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.

**Shortcut:**

Click the button for closing the application window.
Commands - [Edit] menu

[Edit] - [Undo] command
This erases the change just made and returns to the previous form.

Keyboard shortcut: [Ctrl]+[Z]

[Edit] - [Redo] command
This cancels an [Undo] command that has just been run.

Keyboard shortcut: [Ctrl]+[Y]

[Edit] - [Cut] command
This deletes the selected object, and copies it to the clipboard. The contents of the clipboard are maintained until another object is copied to the clipboard. To paste the clipboard contents, run the [Edit] - [Paste] command.

Keyboard shortcut: [Ctrl]+[X]

[Edit] - [Copy] command
This copies the selected object to the clipboard. The contents of the clipboard are maintained until another object is copied to the clipboard. To paste the clipboard contents, run the [Edit] - [Paste] command.

Keyboard shortcut: [Ctrl]+[C]

[Edit] - [Paste] command
This copies the contents of the clipboard, pasting them at the selected on-screen location.

Keyboard shortcut: [Ctrl]+[V]

Related Topics
Copying an object

[Edit] - [Delete] command
This deletes the selected object. The deleted object is not copied to the clipboard.

Keyboard shortcut: [Delete]

[Edit] - [Select All] command
This selects all objects displayed on screen.

Keyboard shortcut: [Ctrl]+[A]
Commands - [View] menu

[View] - [Zoom] - [Zoom In] command
This displays an enlarged view of the object.
Keyboard shortcut: [Ctrl]+[Page Down]

[View] - [Zoom] - [Zoom Out] command
This displays an reduced view of the object.
Keyboard shortcut: [Ctrl]+[Page Up]

[View] - [Zoom] - [Custom...] command
This specifies the ratio for enlarging or reduced the view of the object.
Running this command opens the [Zoom Setup] dialog box.
To set the zoom ratio used when Dr. Engrave starts, from the [File] menu, click [Preferences].
Keyboard shortcut: [Ctrl]+[Page Up]

[Zoom Setup] dialog box

(1) Enter the view ratio as a percentage.
Any integer from 1 to 800 can be entered.

(2) Dragging this slider up or down changes the view ratio.
Any integer from 1 to 800 can be entered.

[View] - [Fit to Screen] command
This command expands or reduces the size of the object shown to fill the screen.

[View] - [Toolbar] command
This toggles the display of the toolbar on or off.
The toolbar is provided with buttons for running Dr. Engrave commands such as [Open...] and [Save]. Moving the mouse pointer over a button displays the button’s name.
Toggling off the display of the toolbar enlarges the area of the edit screen.

Related Topics
Toolbar buttons

[View] - [Object Info.] command
This toggles the display of the object information bar on or off.
The object information bar shows the position of the mouse pointer, as well as the object's centerpoint, dimensions, angle, and slant.
Toggling off the display of the object information bar enlarges the area of the edit screen.

[View] - [Status Bar] command
This command toggles display of the status bar window on or off.
The status bar shows helpful comments about commands. We recommend leaving the status bar on until you're familiar with how Dr. Engrave works.
Turning off the status bar enlarges the object's display area.

[View] - [Layout Info.] command
This displays or hides the layout information bar.
The layout information bar shows the position of the lower-left point (start point) of the plate laid out at the lower left, the spacing of adjacent templates, the presently displayed page, and the page feed buttons.
You can display or hide the layout information bar only when more than one plate is laid out. At this time, the object information bar does not appear.
Turning off the layout information bar enlarges the object's display area.

This displays or hides the guide lines. You can display or hide the guide lines only when more than one plate is laid out. Using the guide lines, you can make these settings with the mouse:
- The position of the lower-left point (start point) of the plate laid out at the lower left
- The spacing between adjacent plates.

[View] - [Show Grid] command

This toggles the display of the grid on or off.

[View] - [Snap To Grid] command

When this is on, objects are automatically aligned with the grid lines. Alignment with the grid lines can make it easier to arrange two or more objects and make settings for object size. When Dr. Engrave has just been installed, this function is off. To change the snap point, hold down the [Ctrl] key and click on the desired point.

The snap point can be a point around the perimeter of the object (any of eight points) or a point at the center of the object.

[View] - [Grid Setup...] command

This makes the settings for grid interval, whether the grid is displayed, and whether the snap to grid function is on or off. Running this command displays the [Grid Setup] dialog box.

[Grid Setup] dialog box

(1) Enter the interval for horizontally adjacent grid lines. When Dr. Engrave has just been installed, this is set at 5.0 mm (0.197 inch).

Setting range: 0 to 100 mm (0 to 4 inch)

Related Topics
Changing the Measurement System for Numerical Values

(2) Enter the interval for vertically adjacent grid lines. When Dr. Engrave has just been installed, this is set at 5.0 mm (0.197 inch).

Setting range: 0 to 100 mm (0 to 4 inch)

Related Topics
Changing the Measurement System for Numerical Values

(3) This toggles the display of the grid on or off.

(4) This toggles the function for snapping objects to the grid on or off.

(5) The grid is shown with dotted lines.

(6) The grid is shown with unbroken lines.
Commands - [Format] menu

[Format] - [Font...] command

This is used to select the font for a block of text. Running this command opens the [Font Select] dialog box. When a block of text has been selected, this command sets its font. When no text is selected, this command sets the font used when text is entered. To set the default font used when entering text, from the [File] menu, click [Preferences].

[Font Select] dialog box

1. This displays the selected font. Choosing a font from the font list makes the display change. Clicking [OK] changes the font setting to the one displayed here.

2. This displays the fonts available for selection. Click on a font in the list to choose it. Dr. Engrave can use TrueType fonts registered with Windows as well as stroke fonts that you create yourself.

3. This displays the form of the selected font.

[Format] - [Style] command

This specifies a style (bold or italic) for a text string. To specify a setting other than line width or slant, click [Other]. The Text String Properties or Text Box Properties screen appears.

[Format] - [Direction] command

This setting determines whether the selected text is written vertically or horizontally.

[Format] - [Line Alignment] command

You can center a text string or align it with the left margin, the right margin, or both (justified). Also, for a text box, you can attach text above or below the box. You can also lay out text with proportional spacing in a text box. You can also make the settings from the Text String Properties or Text Box Properties screen.

[Format] - [Line Spacing] command

This specifies the spacing between adjacent lines. To specify a line spacing other than one of the available selections, click [Other]. The Text String Properties or Text Box Properties screen appears.

[Format] - [Character Spacing] command

This specifies the spacing between adjacent characters. To specify a character spacing other than one of the available selections, click [Other]. The Text String Properties or Text Box Properties screen appears.

[Format] - [Make Stroke...] command

This converts the selected text string to stroke characters. This extracts the centerlines of the characters and creates stroke characters. Running this command displays the [Select Stroke Font] dialog box.

Depending on the font, stroke characters may not be correctly aligned in horizontal rows or may not be converted to the character's originally designed line segments. In such cases, use the [Format] - [Edit Stroke...] command to correct the shape of the stroke characters.

[Select Stroke Font] dialog box

1. Stroke Font Name

Choose a stroke font. To create a new stroke font, enter the font name in this text box.
[Format] - [Edit Stroke...] command

This corrects the shape of stroke characters. This starts the program for editing stroke characters (SFEdit). The first character of the selected text string appears on the edit screen. For more on how to use SFEdit, see “Appendixies - Operating Procedures of SFEdit.”

[Format] - [Properties...] command

This is used to change the attributes and size of a text string or text box using numerical values. When you’ve selected a text string, the Text String Properties screen appears. When you’ve selected a text box, the Text Box Properties screen appears.
Commands - [Shape] menu

[Shape] - [Properties...] command

This is used to change the form of an object by modifying its numerical values. A dialog box for changing the shape appears. The items displayed vary according to the type of object selected. Selecting a polygon (polyline) with three or more vertices displays the [Polygon Properties] screen. When there are two vertices, the [Straight Line Properties] screen appears. To open the properties of a template, then while editing a template file, make sure no object is currently selected, and run this command.

Text String Properties
Shape Properties
Polygon Properties
Straight Line Properties
Text Box Properties
Template Properties

Keyboard shortcut: [Alt] + [Enter]

[Text String Properties] dialog box

(1) Text Height
Enter the height of the text. The setting immediately affects all characters in the text string. Changing this value also makes the [Height] value change accordingly.

(2) Height
Enter the overall height for the text string. Changing this value also makes the [Height] value change accordingly.

(3) Width
Enter the overall width for the text string.

(4) Aspect
Enter the size as a ratio, with the vertical/horizontal aspect (vertical/horizontal ratio) when the text or shape was created as 1. Entering a number changes the width without varying the height. Enter 2 to double the width. Enter 0.5 to halve it.

(5) Angle
Enter the angle of rotation for the object. The unit is in degrees. A negative angle may also be entered. Entering a negative angle rotates the object clockwise.

(6) Character Spacing
Enter the pitch (interval) for adjacent characters. Character size does not change. Changing this value also makes the [Width] value change accordingly.

(7) Line Spacing
This specifies the spacing between adjacent lines.

(8) This shows the shape of the text.

(9) Choose the portion of the text for which you want to enter the height.

(10) Keep Aspect for input
This causes an object’s aspect to be maintained at a fixed value when a numerical value is entered for Height or Width. When a value is entered for Height (or Width), the value of Width (or Height) changes automatically.

(11) Line Alignment
You can center a text string or align it with the left margin, the right margin, or both (justified).

(12) This setting determines whether the selected text is written vertically or horizontally.

Related Topics
Changing the Measurement System for Numerical Values
(13) **Slant**
Enter the degree of slant of the object.  
The unit is in degrees.  
Entering a positive angle makes the object slant to the right.  
Entering a negative angle makes the object slant to the left.

(14) **Font**
This displays the name of the selected font.  
To change the font for the text, click on the down-pointing triangle.

(15) **Boldness**
Dragging the slider changes the thickness (weight) of text.  
A font cannot be made narrower than its standard weight.  
The left-hand end of the slider is standard weight, and the right-hand end is maximum weight.

(16) **Color**
Choose the line color of the text or shape.  
When [Fill] is on, this changes to the fill color.

**Related Topics**
Changing the engraving depth

(17) **Fill**
When on, the interior of the object (text or shape) is engraved by flat-drag cutting.  
The route along which the tool moves (the tool path) is created along the contours of the object. Set the tool-path pitch with [Pitch].  
The tool path is created on the inner side of the object. To engrave an object's contour lines, select [Contour].

(18) **Contour**
After flat-drag engraving of the object finishes, the object's contours are engraved.

(19) **Pitch**
This sets the fill pitch (the spacing between adjacent tool paths).  
Normally you should enter the diameter of the blade installed on the engraving machine. To ensure an attractive finish for flat-drag engraving, the pitch is generally set at a value smaller than the blade diameter.

**Related Topics**
Changing the engraving depth

---

**[Shape Properties] dialog box**

(1) **Width**
Enter the object's width.

**Related Topics**
Changing the Measurement System for Numerical Values

(2) **Angle**
Enter the angle of rotation for the object.  
The unit is in degrees.  
A negative angle may also be entered. Entering a negative angle rotates the object clockwise.

(3) **Twist**
This rotates the center of the star without change the positions of the vertices.  
Enter the angle of rotation. The units of measurement are degrees.  
Entering a positive value rotates the star counterclockwise.  
Entering a negative value rotates it clockwise.  
This can be used only with stars.

(4) **Color**
Choose the line color of the text or shape.  
When [Fill] is on, this changes to the fill color.

**Related Topics**
Changing the engraving depth

(5) **Form**
Choose the type of shape.

(6) **Shape**
Drag the slider to change the shape of the object.  
Depending on the type of shape you chose, the way the shape changes may vary.
(7) Fill
When on, the interior of the object (text or shape) is engraved by flat-drag cutting.
The route along which the tool moves (the tool path) is created along the contours of the object. Set the tool-path pitch with [Pitch].
The tool path is created on the inner side of the object. To engrave an object's contour lines, select [Contour].

(8) Pitch
This sets the fill pitch (the spacing between adjacent tool paths).
Normally you should enter the diameter of the blade installed on the engraving machine. To ensure an attractive finish for flat-drag engraving, the pitch is generally set at a value smaller than the blade diameter.

(9) Contour
After flat-drag engraving of the object finishes, the object's contours are engraved.

(10) Height
Enter the object's height.

(11) Slant
Enter the degree of slant of the object.
The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(12) Round-corner Radius
Enter the corner roundness for a rounded-corner rectangle.

(13)
This shows the shape of the graphic.

[Polygon Properties] dialog box

(1) Width
Enter the object's width.

Related Topics
Changing the Measurement System for Numerical Values

(2) Angle
Enter the angle of rotation for the object.
The unit is in degrees.
A negative angle may also be entered. Entering a negative angle rotates the object clockwise.

(3) Aspect
Enter the size as a ratio, with the vertical/horizontal aspect (vertical/horizontal ratio) when the text or shape was created as 1.
Entering a number changes the width without varying the height. Enter 2 to double the width. Enter 0.5 to halve it.

(4) Color
Choose the line color of the text or shape.
When [Fill] is on, this changes to the fill color.

Related Topics
Changing the Measurement System for Numerical Values

(5) Height
Enter the object's height.

Related Topics
Changing the Measurement System for Numerical Values

(6) Slant
Enter the degree of slant of the object.
The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(7) Keep Aspect for input
This causes an object's aspect to be maintained at a fixed value when a numerical value is entered for Height or Width. When a value is entered for Height (or Width), the value of Width (or Height) changes automatically.

Related Topics
Changing the Measurement System for Numerical Values
(8) Fill
When on, the interior of the object (text or shape) is engraved by flat-drag cutting.
The route along which the tool moves (the tool path) is created along the contours of the object. Set the tool-path pitch with [Pitch].
The tool path is created on the inner side of the object. To engrave an object's contour lines, select [Contour].

(9) Contour
After flat-drag engraving of the object finishes, the object's contours are engraved.

(10) Pitch
This sets the fill pitch (the spacing between adjacent tool paths).
Normally you should enter the diameter of the blade installed on the engraving machine. To ensure an attractive finish for flat-drag engraving, the pitch is generally set at a value smaller than the blade diameter.

[Related Topics]
Changing the Measurement System for Numerical Values

[Straight Line Properties] dialog box

(1) Start Point
Enter the distance from the line's start point to the origin point.
The start point is the drag starting point when plotting the line.

(2) End Point
Enter the distance from the line's end point to the origin point.
The end point is the drag ending point when plotting the line.

(3) Color
Choose the line color.

[Related Topics]
Changing the Measurement System for Numerical Values

[Related Topics]
Changing the engraving depth
[Text Box Properties] dialog box

[Text Box] tab

(1) This shows the layout of the text string in the text box.

(2) This lays out a right-aligned text string.

(3) This lays out a horizontally centered text string. When [Format] - [Direction] - [Horizontal] is selected, you can make the settings for justification and proportional spacing. Click the button to cycle through the sequence. When justification or proportional spacing has been selected, you cannot enter anything on the [Text] tab for [Height] or [Character Spacing].

(4) This lays out a left-aligned text string.

(5) This lays out a vertically centered text string. When [Format] - [Direction] - [Vertical] is selected, you can make the settings for justification and proportional spacing. Click the button to cycle through the sequence. When justification or proportional spacing has been selected, you cannot enter anything on the [Text] tab for [Height] or [Character Spacing].

(6) This lays out a top-aligned text string.

(7) This lays out a bottom-aligned text string.

(8) Origin
Enter the distance from the lower-left point of the engraving area to the lower-left point of the text box.

(9) Size
Enter the size of the text box.

(10) Drag to rotate the text box.

(11) Enter the angle of rotation for the text box. The units of measurement are degrees. Entering a positive value rotates the text box counterclockwise. Entering a negative value rotates it clockwise.

Related Topics
Changing the Measurement System for Numerical Values
(12) Numberir
Numeric values are automatically entered in the text box. Enter the starting value in [Initial Value] and the value for incrementing it in [Increase]. You can also insert a zero in front of the number for [Initial Value]. As shown in the figure, numbering proceeds from the lower left to the upper right.

* When [Initial Value] = 1 and [Increase] = 1

(4) Character Spacing
Enter the pitch (interval) for adjacent characters. Character size does not change. Changing this value also makes the [Width] value change accordingly.

(5) Line Spacing
This specifies the spacing between adjacent lines.

(6) This shows the shape of the text.

(7) Slant
Enter the degree of slant of the object. The unit is in degrees. Entering a positive angle makes the object slant to the right. Entering a negative angle makes the object slant to the left.

(8) Text Height
Enter the height of the text. The setting immediately affects all characters in the text string. Changing this value also makes the [Height] value change accordingly.

(9) Choose the portion of the text for which you want to enter the height.

(10) Keep Aspect for input
This causes an object's aspect to be maintained at a fixed value when a numerical value is entered for Height or Width. When a value is entered for Height (or Width), the value of Width (or Height) changes automatically.

(11) Font
This displays the name of the selected font. To change the font for the text, click on the down-pointing triangle.

(12) Boldness
Dragging the slider changes the thickness (weight) of text. A font cannot be made narrower than its standard weight. The left-hand end of the slider is standard weight, and the right-hand end is maximum weight.

(13) Color
Choose the line color of the text or shape. When [Fill] is on, this changes to the fill color.
(14) This setting determines whether the selected text is written vertically or horizontally.

(15) Fill
When on, the interior of the object (text or shape) is engraved by flat-drag cutting. The route along which the tool moves (the tool path) is created along the contours of the object. Set the tool-path pitch with [Pitch]. The tool path is created on the inner side of the object. To engrave an object's contour lines, select [Contour].

(16) Contour
After flat-drag engraving of the object finishes, the object's contours are engraved.

(17) Pitch
This sets the fill pitch (the spacing between adjacent tool paths). Normally you should enter the diameter of the blade installed on the engraving machine. To ensure an attractive finish for flat-drag engraving, the pitch is generally set at a value smaller than the blade diameter.

[Shape] - [Fill] command
This performs flat-drag engraving of the interior of a graphic or text. To engrave an object's contour lines, select [Contour]. When [Contour] is not selected, the contours of filled objects appear in gray. Running this command displays the [Fill Setup] dialog box.

Specifying filling of combined polygons lets you perform flat-drag engraving between the inner and outer sides, as shown in the figure.

[Fill Setup] dialog box
(1) Pitch
This sets the fill pitch (the spacing between adjacent tool paths). Normally you should enter the diameter of the blade installed on the engraving machine. To ensure an attractive finish for flat-drag engraving, the pitch is generally set at a value smaller than the blade diameter.

(2) Color
Choose the color of fill lines.

[Template Properties] dialog box
(1) Size
Enter the size of the template.
(3) Fill
When on, the interior of the object (text or shape) is engraved by flat-drag cutting. The route along which the tool moves (the tool path) is created along the contours of the object. Set the tool-path pitch with [Pitch]. The tool path is created on the inner side of the object. To engrave an object's contour lines, select [Contour].

(4) Contour
After flat-drag engraving of the object finishes, the object's contours are engraved.

[Shape] - [Move Shape...] command
This specifies an object's position as a certain distance from the origin point. Running this command displays the [Moving a Shape] dialog box.

[Moving a Shape] dialog box

(1) Choose which portion of the object is to be used for specifying the position.

When more than one object is chosen, a rectangle enclosing all the objects is displayed.

(2) X, Y
This specifies an object's position as a certain distance from the origin point.

* When the object's center is taken to be the reference point

Related Topics
Changing the Measurement System for Numerical Values

[Shape] - [Mirror] command
This flips an object from left to right, creating a mirror image.

[Shape] - [Convert to Polygon] command
This changes the attribute for an object other than a polygon to the attribute for a polygon. Converting an object to a polygon with this command makes it possible for you to edit its points (vertices). Once an object has been converted to a polygon, it cannot be returned to its original attribute (text, rectangle, rounded rectangle, circle/ellipse, or star).

[Shape] - [Combine Polygons] command
A number of objects can be grouped together and united into a single polygon. They can then be moved or resized while maintaining the layout the objects had before they were joined together. The points of an object polygon that has been joined together in this fashion can be edited in the same way as an ordinary polygon.

Specifying filling of combined polygons lets you perform flat-drag engraving between the inner and outer sides, as shown in the figure.
[Shape] - [Break Apart] command

A polygon can be split into individual parts.

[Shape] - [Server Vertex] command

This severs a polygon (polyline) at a specified location. To specify the severance point, click on one of the polygon's line segments or vertices.

Keyboard shortcut: [Alt]+[Delete]

[Shape] - [Insert Vertex] command

This adds a vertex at the specified location.

Keyboard shortcut: [Insert]

Related Topics
Adding a vertex to a polygon (polyline)

[Shape] - [Delete Vertex] command

This deletes the selected vertex.

Keyboard shortcut: [Delete]

Related Topics
Deleting a vertex of a polygon (polyline)

[Shape] - [Connect Vertex] command

This connects the endpoints of an open polygon (polyline) with a line. To connect vertices, choose two open endpoints of a polygon (polyline), then run this command.

Connecting to the endpoint of a different polygon (polyline)
1. Select the target polygon.
2. At the [Shape] menu, click [Combine Polygons].
3. Select the two endpoints.
4. At the [Shape] menu, click [Connect Vertex].

Keyboard shortcut: [Alt]+[Insert]
**[Shape] - [Symbols] command**

This adds a symbol to the file being edited.
Running this command opens the [Symbol] dialog box.

**[Symbol] dialog box**

1. The symbol and group names appear. Click the tab and select the group.
2. The name of the selected symbol is displayed. Entering a symbol name selects the specified symbol.
3. A list of symbol names is displayed. Click on the name of a symbol to select it.
4. This deletes the selected symbol.
5. This changes the name of the currently selected group.
The [Change Group Name] dialog box appears. Enter the name of the group in the dialog box.
6. This deletes the currently selected group. Any symbols registered in the group are all deleted as well.
7. This adds the selected symbol to the file being edited.
8. A list of symbol shapes is displayed. Click on a symbol to select it.

**[Shape] - [Add Symbol] command**

It is used to register a symbol with a Dr. Engrave object.
Running this command opens the [Add Symbol] dialog box.

**[Add Symbol] dialog box**

1. Select the group where the symbol is to be registered. Click to display a list of existing group names. To add a new group, click [New Group].
2. Enter the symbol name for the selected object.
3. The selected object is registered as a symbol.
4. This adds a new group for the symbol. The [New Group] dialog box appears. Enter the name of the group in the dialog box.
Commands - [Layout] menu

[Layout] - [Layout Setup] command

This lays out multiple templates within the area.

If you want to lay out a template file that’s being edited, save the file before you run this command. After you change to the Plate Layout mode, you can’t save the template file.

Running this command displays the [Layout Setup] dialog box.

[Layout Setup] dialog box

(1) Origin
Enter the position of the lower-left point of the plate laid out at the lower left within the page.
Enter the distance from Dr. Engrave’s origin point.

(2) Spacing
Set the spacing between adjacent plates.

(3) Quantity
Enter the number of laid-out templates.

(4) V Cut
Enter the cutting-in amount for the plate outline.
You can engrave a number of plates on a single plate, and after engraving, separate the plates along the V-cut lines.
The plate size after engraving is reduced by an amount equal to the V-cut width. To obtain the desired finished plate size, specify a plate size with the V-cut width already added to it.
The V-cut width may differ according to the blade configuration and cutting-in depth.
To set the V-cut cutting-in depth, set the color of the line.
When on, the plate spacing is set at 0 (zero).

Related Topics
Dividing a single plate to create multiple plates
Changing the engraving depth

(5) Color
Choose the color of the V-cut line.
The color shows the cutting-in depth. The depths of the various colors can be set with the driver for the engraving machine. For more information about how to make the settings, see the help screens for the driver.

Related Topics
Changing the engraving depth

[Layout] - [Edit Template] command

This changes the contents of an imported template.
Running this command calls up the Template Edit screen.
Changes in the values immediately affect the laid out plates. Note that the referenced template file does not change.
To go back to the Plate Layout screen, run the [Return to Layout] command.

[Layout] - [Return to Layout] command

When editing a template with the [Edit Template] command, this returns you to the Plate Layout screen.

[Layout] - [Move To Front] command

This changes the front-back relationship of the objects.
The selected object is moved to the front.

Keyboard shortcut: (Shift)+{Page Up}
Commands - [Help] menu

[Help] - [Contents] command
This displays the contents page for online help.

[Help] - [About Dr. Engrave...] command
This displays the version number and copyright information for Dr. Engrave.

[Layout] - [Move To Back] command
This changes the front-back relationship of the objects. The selected object is moved to the back.

Keyboard shortcut: [Shift]+[Page Down]

[Layout] - [Align] command
All selected objects are aligned at their centers.
If you have selected a number of objects while holding down the [Shift] key, the objects are overlaid atop the last object you chose.
If you've selected a number of objects by dragging an area, the objects are overlaid atop the object in the foreground.

Related Topics
Aligning the centers of a number of objects
If You Think There's a Problem
If You Think There's a Problem

Dr. Engrave doesn't function

Does the computer you're using provide the correct operating environment for Dr. Engrave?

Check the conditions for the Dr. Engrave operating environment and make sure that the computer offers a suitable environment.

Was the software installed using the setup program?

The setup program puts the files for Dr. Engrave in the necessary locations to enable the software to be used under Windows.

Engraving machine doesn't function

Was the correct port selected for the printer driver?

The data-output port is set with the printer driver. Open the driver's properties, and on the [Details] tab, check the setting for [Print to the following port:].

Is the cable connected?

Switch off the power to the computer and the output device, and use an interface cable to connect the two devices.

Is the correct type of cable used?

The type of interface cable may vary according to the computer model. Make the connection with the correct type of cable for the computer. Be sure the computer and the output device are both switched off before attempting to attach or disconnect the interface cable.

Error Messages

XXXXX Illegal Font Select.

The Dr. Engrave file you tried to open contains fonts that are not registered in Windows. When this happens, a list of substitute fonts is displayed. The file may have been made on a machine with a different font environment, or some fonts may have been deleted from Windows. To reproduce the original image, make sure the necessary fonts are installed.

Not enough memory.

If insufficient memory occurs during processing, close all other applications or restart Windows. If the message about insufficient memory still appears, check the amount of free space on your hard disk. Windows normally uses a portion of the hard disk for virtual memory, and it may be that there is not enough space left on the hard disk. If this is the case, free up space on the hard disk by deleting unneeded files or moving them to another disk. If the message about insufficient memory still appears after doing this, it is recommended that you increase the amount of memory in your computer.

Could not generate outline.

An outline could not be extracted because of the faint color of data imported using a scanner or Windows bitmap data imported with the [Import] command. Adjust the data to a darkness that allows an outline to be extracted and import the data again.

Related Topics

Using a scanner to import an object
Importing bitmap data
If You Think There's a Problem

Other symptoms

The stroke characters are not evenly aligned in a horizontal row.

When horizontal stroke characters are entered, the characters may not be evenly aligned in a horizontal row.

This happens because the spacing between the base line and the text differs from one character to another. When text is written horizontally, the base lines of adjacent characters are lined up along a horizontal line so that there is no unevenness. Because the character centerlines are extracted and converted to stroke characters, the spacing between the base line and the character may become ragged, as shown in the figure.

If this happens, correct the shape of the characters so that the spacing between the base line and the character becomes uniform.
The stroke characters are not converted correctly.

When text is been converted to stroke characters, some text may not be converted correctly. Here are some of the main reasons why this may happen.

- The width of the lines forming the characters is uneven.

\[ D \rightarrow \]

- The characters are too wide, and the direction of line extension cannot easily be determined.

\[ M \rightarrow \]

- Serifs, balls, and other flourishes may deform the lines.

\[ n \rightarrow \]

In such cases, use the [Format] - [Edit Stroke...] command to correct the shape of the stroke characters.
Appendixies
Operating Procedures of SFEdit

1 Names and functions

(1) Title bar
The file name, base font name and program name are displayed here.
The window can be moved by dragging the title bar.

(2) Menu Bar
Runs the various commands for SFEdit.

(3) Toolbar
The toolbar is provided with buttons for running SFEdit commands such as [Open...] and [Save]. Moving the mouse pointer over a button displays a brief description of the button's function.

(4) The size of the box differs according to the type of base font and the character. Normally you should create the text so that it fits inside the box.

(5) Base font text
This is displayed as a rough draft for editing stroke characters. A base font serves as the design base for a stroke font.
If you don't want to display base font text, set [View] - [Base Font] to "off."

(6) Stroke characters
All stroke characters are made up of polylines and lines.
You can edit them by adding or deleting vertices, adding line segments, and so on.

(7) Base line
This is the reference line for lining up a text string horizontally. When text is written horizontally, the base lines of adjacent characters are lined up along a horizontal line so that there is no unevenness.

(8) Popup menu
Clicking the right mouse button within an editing area makes a menu appear.
You can use this menu to run the following commands.

(9) When the mouse pointer is moved close to here, the pointer changes to a diagonal arrow. You can then change the window size by dragging.

(10) Close button
This ends the program.
If changes made to the file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.

(11) Maximize button
This expands the window to fill the screen.

(12) Minimize button
This shrinks the window to a button on the taskbar.
2 Operation Procedures

Step1: Choose the text

Choose the character whose shape you want to touch up. The character you chose appears on the SFEdit editing screen, where you can reposition vertices, add line segments, and do other things as well.

1. Click on the toolbar's text-entry box, then enter the text string. If a text string has already been entered, go to 2 below.

2. Click the \[ \text{ or } \] button. The presently selected character is displayed in reverse video. Use these buttons to move the reversed portion and select the desired character.

Step2: Correct the shape of the character

Use SFEdit's editing features to correct the shape of the character. This section describes how to move a vertex, add a vertex, and delete a vertex. For other editing functions, see the explanation for the particular command.

Moving a vertex

1. Click the \[ \] button.
2. Click on a polyline (or straight line).
3. Drag the vertex ( ).

* To select a number of vertices, hold down the [Shift] key while clicking on each vertex ( ). Alternatively, drag an area that includes the vertices you want to select. To move the vertices, drag any one of the selected vertices ( ).

Adding a vertex

1. Click the \[ \] button.
2. Click on a polyline (or straight line).
3. Position the pointer over a line, and click. The location for adding the vertex ( ) appears.

4. From the [Shape] menu, click [Insert Vertex]. You can also double-click on a line in a graphic and add a vertex.
Deleting a vertex

1. Click the button.
2. Click on a polyline (or straight line).
3. Click on the vertex.
   The selected vertex changes to a square with a border ( ).
   To delete two or more vertices at the same time, hold down the [Shift] key as you click on each vertex ( ). Alternatively, drag the mouse over the vertices to be deleted.
4. From the [Shape] menu, click [Delete Vertex].

Step3: Save the file

Save the corrected character to a file.
Saving the file causes the results of the change to immediately affect the text string referencing this file.

1. Click the button.
   The [Save As] dialog box appears. If you're editing an existing file, no dialog box appears.
2. Enter the name of the file and click [Save].
3 Basic Operations

Selecting a vertex
1. Click the button.
2. Click on a polyline (or straight line).
3. Click on the vertex.
   The selected vertex changes to a square with a border ( ).

When a vertex is chosen, pressing the [Tab] key selects a different vertex. To invert the vertex selection order, hold down the [Shift] key and press [Tab].

Selecting multiple vertices
1. Click the button.
2. Click on a polyline (or straight line).
3. Hold down the [Shift] key and click on each vertex ( ). Alternatively, drag the mouse over the vertices to be selected.

Each selected vertex changes to a square with a border ( ). To select all the vertices included in a polyline (or straight-line) shape, hold down the [Ctrl] key as you click on the vertex.

Canceling the selection of a vertex
1. Click the button.
2. Click on an area other than the selected vertex.

Moving a vertex horizontally or vertically
1. Click the button.
2. Click on a polyline (or straight line).
3. While holding down the [Shift] key, drag the vertex ( ) up, down, or to the left or right.

Adding a vertex
1. Click the button.
2. Click on a polyline (or straight line).
3. Position the pointer over a line, and click. The location for adding the vertex ( ) appears.
4. From the [Shape] menu, click [Insert Vertex].

You can also double-click on a line in a graphic and add a vertex.
Deleting a vertex

1. Click the button.
2. Click on a polyline (or straight line).
3. Click on the vertex.
   The selected vertex changes to a square with a border (■).
   To delete two or more vertices at the same time, hold down the [Shift] key as you click on each vertex (■). Alternatively, drag the mouse over the vertices to be deleted.
4. From the [Shape] menu, click [Delete Vertex].

Selecting a polyline (or straight line)

1. Click the button.
2. Move the mouse cursor to the polyline (or straight line) object to be selected, and click the mouse.
3. The symbols ■ and ▲ appear around the selected polyline (or straight line).

When a polyline (or straight line) is chosen, pressing the [Ctrl] and [Tab] key selects a different polyline (or straight line). To invert the polyline (or straight line) selection order, hold down the [Shift] and [Ctrl] key then press [Tab].

Selecting multiple polylines (or straight lines)

1. Click the button.
2. While holding down the [Shift] key, click on each of the polylines (or straight lines) you wish to select. Alternatively, drag the mouse over the polylines (or straight lines) to be selected.

Canceling the selection of a polyline (or straight line)

1. Click the button.
2. Click on an area other than the selected polyline (or straight line).

Moving an polyline (or straight line) horizontally or vertically

1. Click the button.
2. Click on the polyline (or straight line) to select it.
3. While holding down the [Shift] key, drag the polyline (or straight line) up, down, or to the left or right.
Making an polyline larger or smaller

1. Click the button.
2. Click on the polyline to select it.
3. Change the size of the polyline (or straight line) by dragging the points (■ and ▲) that appear around the object.

   The size can be freely changed by dragging a square point (■).
   The size can be changed while maintaining the shape's vertical and horizontal aspect by holding down the [Shift] key while dragging.

![Diagram of a polyline with square and triangular points]

   The triangular points (▲) on the left and right can be dragged to change the horizontal size.

![Diagram showing dragging a triangular point to change horizontal size]

   The triangular points (▲) above and below can be dragged to change the vertical size.

![Diagram showing dragging a triangular point to change vertical size]

Drawing a polyline (or straight line)

1. Click the button.
2. Click on the vertices and draw the polyline (or straight-line) shape.
3. To end creation of a polyline shape, double-click on the end point.
   To create straight line, double-click on the second vertex.
4 Commands

Toolbar buttons

The toolbar is provided with buttons for running SFEdit commands such as [Open...] and [Save]. Moving the mouse pointer over a button displays a brief description of the button's function.

The buttons provided on the toolbar are as shown below. Click on a button's icon to display an explanation of the command.

1. Text entry box
   Enter the text you want to edit. Select a character by clicking the left or right arrow button or double-clicking on the character. To edit or browse line characters that have already been registered, then at the [Shape] menu, click [Character List].

2. Arrow buttons
   These choose the character you want to edit from the text string in the text entry box. The character in the text entry box that is displayed in reverse video is the presently selected character. Use these buttons to move the reversed portion and select the desired character.

This selects a polyline (or straight line). To select a polyline (or straight line), move the mouse pointer over the polyline (or straight line) and click. When a polyline (or straight line) is chosen, pressing the [Ctrl] and [Tab] key selects a different polyline (or straight line). To invert the polyline (or straight line) selection order, hold down the [Shift] and [Ctrl] key then press [Tab].

This creates a polyline (or straight line) by clicking on vertices. To end creation, double-click on the end point. Right-click or press [Esc] while creation is in progress to delete a vertex. To create a line, double-click on the second vertex (end point). Clicking this button changes the mouse pointer to the shape-drawing tool ( ).

This opens a SFEdit file. Running this command opens the [Open] dialog box.

This saves the file, overwriting the previous version of the file.

This cancels an [Undo] command that has just been run.

This cancels an [Undo] command that has just been run.

This shifts the position of a vertex and changes the shape of a polyline (or straight line). Clicking this button then clicking overtop the polyline (or straight line) displays the vertices ( ). Double-click on a line to add a vertex. Drag one of the square pointers ( ) to change the position of the corresponding vertex. Dragging a vertex to a point near a line or another vertex makes it snap to the line or vertex. To keep it from snapping, hold down the [Ctrl] key while dragging. Making the endpoints of a polyline snap together produces a closed polygon. When a vertex is chosen, pressing the [Tab] key selects a different vertex. To invert the vertex selection order, hold down the [Shift] key and press [Tab].

This enlarges or reduces the view of the object. Clicking the left mouse button shows an enlarged view with the point where clicked at the center. The area to be enlarged can also be specified by dragging with the mouse. Clicking the right mouse button shows a reduced-size view.

This command expands or reduces the size of the object shown to fill the screen.
Commands - [File] menu

**[File] - [New] command**

This creates new stroke fonts.
A dialog box is displayed for selecting the font to serve as the design base for the stroke font (the base font).
If changes made to a file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.

- **Keyboard shortcut:** [Ctrl]+[N]

**[Select Base Font] dialog box**

1. This displays the selected font.
   To choose a font, click the font name in the list or enter the font name.

2. This displays the fonts available for selection. Click on a font in the list to choose it.
   Only TrueType fonts registered in Windows are displayed.

3. This displays the form of the selected font.

**[File] - [Open...] command**

This opens a SFEdit file.
Running this command opens the [Open] dialog box.
If changes made to a file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.

- **Keyboard shortcut:** [Ctrl]+[O]

**[Open] dialog box**

1. Choose the area where the file has been saved.

2. The folders and files in the [Look in] are displayed.
   Double-click on a file to open it. Double-click on a folder to open it and see the files inside.

3. Enter the file name.

4. Select the type of file.
   Only files with the chosen extension are listed. To list all files, choose "All Files (*.*) ."

5. [Open] button
   If a file in the file list has been selected, click this button to open the file.
   If a folder has been selected, click this button to open the folder and view its contents.

6. [Cancel] button
   This closes the dialog box.
[File] - [Save] command

This saves the file, overwriting the previous version of the file. To save the file with a different name or in a different area, use the [Save As...] command.

Keyboard shortcut: [Ctrl]+[S]

[File] - [Save As...] command

This saves the file with a different name. Running this command opens the [Save As] dialog box.

Windows 95 long file names are supported. Normally, "rsf" is used as the file extension.

[Save As] dialog box

(1) Choose the area where the file is to be saved. To enable selection of the created stroke font with Dr. Engrave, save the file in the [Rsf] folder.

(2) The folders and files in the [Save in] are displayed. Double-click on a folder to open it and see the files inside.

(3) Enter the name for saving the file. The extension selected for [Save as type] is appended to the file name.

(4) Select the extension for the file to be saved. The file extension helps Windows determine the application associated with the file. SFEdit files use "rsf" as their extension. Normally, this should be set to "Roland Stroke Font (*.rsf)."

(5) [Save] button
This saves the file to the selected [Save in].

(6) [Cancel] button
This closes the dialog box.

[File] - [Exit] command

This ends the program. If changes made to the file being edited have not been saved, a dialog box asking if you wish to save the changes is displayed.

Shortcut: Click the button for closing the application window.
Appendices

Commands - [Edit] menu

[Edit] - [Undo] command
This erases the change just made and returns to the previous form.

▲ Keyboard shortcut: [Ctrl]+[Z]

[Edit] - [Redo] command
This cancels an [Undo] command that has just been run.

▲ Keyboard shortcut: [Ctrl]+[Y]

[Edit] - [Cut] command
This deletes the selected object, and copies it to the clipboard. The contents of the clipboard are maintained until another object is copied to the clipboard. To paste the clipboard contents, run the [Edit] - [Paste] command.

▲ Keyboard shortcut: [Ctrl]+[X]

[Edit] - [Copy] command
This copies the selected object to the clipboard. The contents of the clipboard are maintained until another object is copied to the clipboard. To paste the clipboard contents, run the [Edit] - [Paste] command.

▲ Keyboard shortcut: [Ctrl]+[C]

[Edit] - [Paste] command
This copies the contents of the clipboard, pasting them at the selected on-screen location. You can only paste SFEdit polylines (or straight lines). Shapes created with another program cannot be pasted via the clipboard.

▲ Keyboard shortcut: [Ctrl]+[V]

[Edit] - [Delete] command
This deletes the selected object. The deleted object is not copied to the clipboard.

▲ Keyboard shortcut: [Delete]

[Edit] - [Select All] command
This selects all objects displayed on screen.

▲ Keyboard shortcut: [Ctrl]+[A]
Appendixies

Commands - [View] menu

[View] - [Zoom In] command
This displays an enlarged view of the object.

Keyboard shortcut: [Ctrl]+[Page Down]

[View] - [Zoom Out] command
This displays a reduced view of the object.

Keyboard shortcut: [Ctrl]+[Page Up]

[View] - [Toolbar] command
This toggles the display of the toolbar on or off. The toolbar is provided with buttons for running SFEdit commands such as [Open...] and [Save]. Moving the mouse pointer over a button displays the button’s name. Toggling off the display of the toolbar enlarges the area of the edit screen.

[View] - [Base Font] command
This toggles the display of the base font on or off.

[View] - [Grid] command
This toggles the display of the grid on or off. The default for grid spacing is 50, both horizontally and vertically. These values do not correspond to any measurement unit. The grid may sometimes not be displayed, depending on the screen’s zoom factor or the grid spacing.

[View] - [Snap To Grid] command
When this is on, polyline and its vertices are automatically aligned with the grid lines. Alignment with the grid lines can make it easier to arrange the position of polyline and vertices. When SFEdit has just been installed, this function is off.

[View] - [Grid Setup...] command
This makes the settings for grid interval, whether the grid is displayed, and whether the snap to grid function is on or off. Running this command displays the [Grid Setup] dialog box.

[Grid Setup] dialog box

1. Enter the interval for horizontally adjacent grid lines. The default value is 50. This value does not correspond to any measurement unit.
   Setting range: 0—1000

2. Enter the interval for vertically adjacent grid lines. The default value is 50. This value does not correspond to any measurement unit.
   Setting range: 0—1000

3. This toggles the display of the grid on or off.

4. This toggles the function for snapping objects to the grid on or off.

5. The grid is shown with dotted lines.

6. The grid is shown with unbroken lines.

[View] - [Fit to Screen] command
This command expands or reduces the size of the object shown to fill the screen.
Appendices

Commands - [Shape] menu

[Shape] - [Character List...] command
This displays a list of characters which have been converted to stroke characters. Running this command displays the [Stroke Font Table] dialog box.

[Stroke Font Table] dialog box

1. A list of characters converted to stroke characters appears. Double-click to make the character appear on the edit screen.

2. Character
This displays a character selected from the list of characters. You can also enter a character and display a registered character.

3. Code
This displays the character code (ASCII) of a character selected from the list of characters. You can also enter a character code and display a registered character.

4. Select the number system of the character code. You can select this item when the base font is 1-byte character font.

5. [Edit] button
This makes the character selected from the list of characters appear on the edit screen.

6. [Insert] button
This adds a character (graphic) chosen from the list of characters to the text now being edited.

7. [Delete] button
This deletes a selected character from the list of characters.

[Shape] - [Regenerate Stroke Character] command
This regenerates the stroke character being edited and displays it on screen. The stroke character being edited is cleared away and replaced with a regenerated stroke character. This is used to redo editing of the character in question from the very beginning.
[Shape] - [Stroke Character Batch Generate...] command
This converts all base-font text to stroke characters. Running this command displays the [Make Stroke All] dialog box.

[Make Stroke All] dialog box
(1) Alphanumeric Only
This converts the alphanumerical text of base font to stroke characters, but don't generates the stroke characters that have already been converted. You can select this item when the base font is 2-byte character font.

(2) All Characters
This converts all base-font text to stroke characters, but don't generates the stroke characters that have already been converted. You can select this item when the base font is 2-byte character font.

(3) This starts to generate the stroke characters.

[Shape] - [Delete Vertex] command
This deletes the selected vertex.

[Shape] - [Connect Vertex] command
This connects two selected vertices with a line. Choose two vertices at the ends of a polyline (or straight line). You can't run this command if only one vertex is chosen or if one or the other of the two vertices isn't an end of a polyline (or straight line).

[Shape] - [Sever Vertex] command
This severs a polyline (or straight line) at a specified location. To specify the severance point, click on the line or vertex.

[Shape] - [Snap to Vertex] command
This overlays the selected vertex on the closest vertex. To snap to the vertex of another polyline (or straight line):

1. Click the [ ] button
2. While holding down the [Shift] key, click the polyline (or straight line) that contains the vertex you want to snap to, and click the polyline (or straight line) you want to snap to.
3. Select the vertex to snap to.
4. From the [Shape] menu, click [Snap to Vertex].

[Shape] - [Insert Vertex] command
This adds a vertex at the specified location.

Keyboard shortcut: [Insert]

Related Topics
Adding a vertex
Commands - [Help] menu

[Help] - [Contents] command
This displays the contents page for online help.

[Help] - [About SFEdit...] command
This displays the version number and copyright information for SFEdit.
5 Error Messages

Base font XXXXX not found. Choose substitute font or click Cancel and install selected font.

The line-character font file you're trying to open has a setting for a base font that's not registered with Windows. The file may have been created on a machine with a different font environment, or the font may have been deleted from Windows. Click [Finish] and install the font in Windows, or click [Substitute] change the setting for the base font. Clicking [Substitute] allows existing line characters to remain without being regenerated. Note that after a font has been substituted, the substitute font is used as the base design for creating line characters.

File input/output failed.

An error occurs when opening or saving a file. If the error appears when saving a file, the disk you want to save the file to is write-protected, or the file you're trying to overwrite is read-only. Save the file on a disk that isn't write-protected, or change the file attributes to enable it to be written to. If the error appears when opening a file, the file you're attempting to open is not in SFEdit file format. Open an SFEdit file.

Not enough memory

If insufficient memory occurs during processing, close all other applications or restart Windows. If the message about insufficient memory still appears, check the amount of free space on your hard disk. Windows normally uses a portion of the hard disk for virtual memory, and it may be that there is not enough space left on the hard disk. If this is the case, free up space on the hard disk by deleting unneeded files or moving them to another disk. If the message about insufficient memory still appears after doing this, it is recommended that you increase the amount of memory in your computer.
Glossary

Object
This is the collective name for shapes and blocks of text.

Dr.Engrave file
This is a file saved in Dr. Engrave format.

Windows BMP (bitmap)
BMP (Windows bitmap) is a standard graphical file format for Windows. It can be used to store bitmap data. All graphics are represented as a collection of dots.

SFEdit file
This is a file saved in SFEdit format. Normally, ".rsf" is used as the file extension.

TrueType font
This is one type of outline font system that represents text as an outline and a filled portion. It is provided as standard on Windows.

Vector data
Vector data is a data format that represents images (text and shapes) as a set of reference points and the lines that connect them. Most draw-type software applications can be used to create vector-data images.

Bitmap data
Bitmap data is a data format that represents images (text and shapes) as a collection of dots. Most paint-type software applications show images as bitmaps.

Resolution
This is a scale that indicates the precision of images displayed on screen, printed on the printer, or acquired with the scanner. The larger the number, the more detailed and attractive is the image it represents.

Gradations
This indicates the smoothness of changes in color when colors are used.

Indicate
This indicates the smoothness of changes in color when colors are used.

Clipboard
The clipboard is used to hold data temporarily when it is being copied or cut. The clipboard is a standard feature of Windows.

CSV
This is one format for saving data from a database, spreadsheet, or the like as a text file. Text (or numerals) entered into fields or cells are exported to a file in comma-separated format. In addition to the CSV format, which uses commas as separators, some programs let you specify tabs or spaces as separators.
# Index

## A

[A] ................................................................................................................................. 50
[About Dr. Engrave] command ................................................................. 53
[About S-FEdit] command ............................................................................ 72
[Acquire] command ......................................................................................... 35
[Add Symbol] command .................................................................................... 51
[Add Symbol] dialog box .................................................................................... 51
Align .............................................................................................................. 27, 28
[Align] command .............................................................................................. 53
Arrow button ..................................................................................................... 65
Aspect .............................................................................................................. 26, 42, 44, 47

## B

[Base Font] command ......................................................................................... 69
Base font text .................................................................................................... 59
"Base font XXXXX not found." ........................................................................... 56
Base line ........................................................................................................... 56, 59
Bitmap data ...................................................................................................... 28, 31, 74
BMP (bitmap) ................................................................................................ 74
BMP file ........................................................................................................... 31
[Break Apart] command ................................................................................... 50

## C

Cancel ............................................................................................................... 12
Changing the engraving depth ...................................................................... 18
Changing the measurement system ............................................................... 29
Changing the point snaps .............................................................................. 28
[Character List] command ............................................................................. 70
[Character Spacing] command ..................................................................... 40
Clipboard ........................................................................................................ 28, 37, 74
Close button .................................................................................................... 7, 59
Code ............................................................................................................... 70
[Combine Polygons] command ................................................................... 49
[Connect Vertex] command ......................................................................... 50
[Contents] command ................................................................................... 53, 72
[Convert to Polygon] command .................................................................. 49
[Copy] command ............................................................................................... 37, 68
"Could not generate outline." .......................................................................... 55
Creating circles ............................................................................................... 26
Creating regular polygons ............................................................................. 27
Creating squares ............................................................................................. 26
CSV ................................................................................................................. 74
[Custom] command ....................................................................................... 38
[Cut] command ............................................................................................... 37, 68
Cutting-in amount ........................................................................................... 21, 24

## D

Default settings ............................................................................................... 36
[Delete] command ........................................................................................... 37, 68
[Delete Vertex] command ............................................................................. 50
Dialog box ........................................................................................................
  [Add Symbol] ................................................................................................. 51
  [Fill Setup] .................................................................................................... 48
  [Font Select] ................................................................................................ 40
  [Grid Setup] .................................................................................................. 39, 69
  [Layout Setup] ............................................................................................... 20, 23, 52
  [Make Stroke All] ....................................................................................... 71

## E

[Edit] menu .................................................................................................... 37, 68
[Edit Stroke] command ................................................................................ 41
[Edit Template] command ........................................................................... 52
Engraving ........................................................................................................
  Cancel ........................................................................................................... 12
  Depth ............................................................................................................ 18
  Engraving at one time .................................................................................. 19, 22
  Origin ........................................................................................................... 18
  Ready .......................................................................................................... 21, 23
  Specified plate ............................................................................................. 25
  Start .............................................................................................................. 21, 23
Engraving area ............................................................................................... 9, 20
Enter the text ................................................................................................. 20, 23
Error messages .............................................................................................. 56, 73
[Exit] command ............................................................................................. 36, 67
Extraction of clear outlines .......................................................................... 30, 31

## F

Feed rate .......................................................................................................... 21, 24
[File] menu .................................................................................................... 34, 66
[Fill] command ............................................................................................... 48
[Fill Setup] dialog box .................................................................................. 48
[Fit to Screen] command .............................................................................. 38, 69
Flat-drag engraving ......................................................................................... 48
[Font] command ............................................................................................. 40
[Font Select] dialog box ................................................................................. 40
[Format] menu ............................................................................................... 40

## G

Gradations ...................................................................................................... 30, 31, 74
Grid ................................................................................................................. 28, 39
[Grid] command ............................................................................................ 69
[Grid Setup] command ................................................................................. 39, 69
[Grid Setup] dialog box ................................................................................. 39, 69
[Guide Lines] command ................................................................................ 39
Overview ....................................................................................... 5
Operation procedures .................................................................... 8, 60
[Open...] command ......................................................................... 66
[Open...] command ......................................................................... 34
Importing a CSV file ................................................................. 25, 35
Importing text file ........................................................................ 25
Importing an object ........................................................................ 30
Importing bitmap data .................................................................... 31
Indicate ........................................................................................ 74
Importing CSV file ........................................................................ 25, 35
[Insert Vertex] command ............................................................. 50

L
[Layout] menu ............................................................................. 52
[Layout Info.] command ............................................................... 38
[Layout Setup] command .............................................................. 52
[Layout Setup] dialog box ............................................................. 20, 23, 52
[Line Alignment] command ......................................................... 40
[Line Spacing] command ............................................................... 40

M
[Make Stroke...] command .......................................................... 40
Maximize button ......................................................................... 7, 59
Measurement system .................................................................... 29
Menu bar ...................................................................................... 7, 59
[Minimize] button ......................................................................... 7, 59
[Mirror] command ........................................................................ 49
[Move Shape...] command .......................................................... 49
[Move To Back] command ............................................................ 53
[Move To Front] command ........................................................... 52
[Moving a Shape] dialog box ........................................................ 49
Multiple plates ............................................................................. 19, 22

N
Names and functions ..................................................................... 7
[New] command .......................................................................... 34, 66
[New File] dialog box .................................................................... 34
"Not enough memory." ............................................................... 55

O
Object .......................................................................................... 7, 14, 74
Change the size ........................................................................... 14, 26
Copy ............................................................................................ 15
Delete ........................................................................................... 15
Import .......................................................................................... 30
Move ............................................................................................ 14
Rotate ......................................................................................... 14
Select ............................................................................................ 14
Slant ............................................................................................. 15
[Object Info.] command .............................................................. 38
Object information bar ............................................................... 7, 59
[Open...] command ..................................................................... 34
[Open...] dialog box ..................................................................... 66
Operating environment .................................................................. 5
Operation procedures ................................................................... 8, 60
Origin ........................................................................................... 7, 18
Overview ....................................................................................... 5

P
Paste ............................................................................................ 37, 68
[Paste] command ......................................................................... 37, 68
Pasting a graphic .......................................................................... 28
[Polygon Properties] dialog box .................................................. 44
Polyline
Changing size ................................................................................ 64
Drawing ....................................................................................... 64
Moving ....................................................................................... 63
Selecting ..................................................................................... 63
Popup menu .................................................................................. 7, 59
Port ............................................................................................. 55
[Preferences...] command ........................................................... 36
[Preferences...] dialog box .......................................................... 36
Preview ........................................................................................ 35
[Print...] command ...................................................................... 35
[Print Preview] command ........................................................... 35
[Print Setup...] command ............................................................ 35
[Properties...] command ............................................................. 41
[Shape] - [Properties...] ............................................................... 42

R
Re-engraving ................................................................................ 25
[Redo] command ......................................................................... 37, 68
[Regenerate Stroke Character] command .................................... 70
Resolution .................................................................................. 30, 31, 74
[Return to Layout] command ...................................................... 52

S
[Save] command ......................................................................... 34
[Save As...] command ................................................................. 34
[Save As] dialog box ..................................................................... 67
[Save As...] command ................................................................. 67
[Save] command ......................................................................... 67
Scanner ...................................................................................... 30, 35
[Select All] command ................................................................. 37, 68
[Select Base Font] dialog box ....................................................... 46
[Select Source] command ........................................................... 35
[Select Stroke Font] dialog box ..................................................... 40
[Server Vertex] command ........................................................... 50
SFEdit file ..................................................................................... 74
SFEdit .......................................................................................... 41
[Shape] menu ............................................................................. 42, 70
[Shape Properties] dialog box ..................................................... 43
[Show Grid] command ................................................................. 39, 69
Snap point ................................................................................... 28
[ SNAP TO GRID] command ......................................................... 39, 69
[ SNAP TO VERT] command ......................................................... 50, 71
Speed ......................................................................................... 21, 24
Starting the software ................................................................... 6
Status bar .................................................................................... 7, 59
[Status Bar] command ................................................................. 38
Straight line
Drawing ...................................................................................... 64
Moving ....................................................................................... 63
Selecting ..................................................................................... 63
[ Straight Line Properties] dialog box ........................................... 45
[ Stroke Character Batch Generate...] command ......................... 71
Stroke characters .......................................................................... 26, 41, 56, 57, 59
[ Stroke Font Table] dialog box ..................................................... 70
[Style] command ......................................................................... 40
Symbol
  Import ................................................................. 29
  Register .............................................................. 29
[Symbol] dialog box ..................................................... 51
[Symbol] command ....................................................... 51

T
  Template ......................................................................... 19, 22
  [Template Properties] dialog box ................................ 19, 22, 48
  Text Box Properties] dialog box ................................. 46
  Text entry box .......................................................... 65
  [Text String Properties] dialog box ............................. 42, 43
  Title bar ........................................................................ 7, 59
  Toolbar .......................................................................... 7, 33, 59
  [Toolbar] command .................................................... 38, 69
  Toolbar buttons ......................................................... 33, 65
  TrueType font ............................................................. 5, 74
  TrueType fonts ........................................................... 10
  TWAIN ........................................................................ 30, 35

U
  [Undo] command ........................................................ 37, 68
  "Unexpected file format." ......................................... 56
  Using symbols ........................................................... 29

V
  V Cut ............................................................................... 52
  Vector data .................................................................... 28, 74
  Vertex
    Adding .......................................................................... 62
    Deleting ....................................................................... 63
    Moving ......................................................................... 62
    Selecting ....................................................................... 62
  Vertex of a polygon (polyline)
    Add ............................................................................. 16
    Delete .......................................................................... 16
    Move ............................................................................ 16
    Select .......................................................................... 15
  Vertical/horizontal aspect .......................................... 26, 42, 44, 47
  Vertices of a polygon (polyline)
    Selecting all ............................................................ 16
    Selecting multiple .................................................... 15
  [View] menu ............................................................... 38, 69

W
  Windows BMP (bitmap) .................................................. 74

X
  "XXXXX Illegal Font Select" ........................................ 55

Z
  [Zoom In] command .................................................... 38, 69
  [Zoom Out] command .................................................. 38, 69